As the dome of twilight sinks below the horizon, a mechanical corps de
ballet starts a slow-motion pirouette with each dancer keeping the
unblinking eye of a telescope locked on a single spot in the heavens.
Shutters open and ancient photons, ending a journey that may have
started before the earth was born, collide with sensors that store an
electron to mark that photon's arrival. With the dance in motion the
directors sit back to watch the show; another imaging session has
begun...
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A Full and Proper Kit
An introduction to the gear of astro-photography

The young recruit is silly – 'e thinks o' suicide;
'E's lost his gutter-devil; 'e 'asn't got 'is pride;
But day by day they kicks him, which 'elps 'im on a bit,
Till 'e finds 'isself one mornin' with a full an' proper kit.
Rudyard Kipling

Like the young recruit in Kipling's poem 'The 'Eathen', a deep-sky imaging beginner starts with little in
the way of equipment or skill. With 'older' imagers urging him onward, providing him with the benefit
of the mistakes that they had made during their journey and allowing him access to the equipment
they've built or collected, the newcomer gains the 'equipment' he needs, be it gear or skills, to excel at
the art. At that time he has acquired a 'full and proper kit' and ceases to be a recruit.
This paper is a discussion of hardware, software, methods and actions that a newcomer might find
useful. It is not meant to be an in-depth discussion of all forms of astro-photography; that would take
many books and more knowledge than I have available. But I hope that my descriptions and graphics
will help a newcomer to the art understand a bit more what is involved in this wonderful pastime.

Rick Saunders
London Centre, RASC
January 2011
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HARDWARE SECTION
A cursory introduction to the hardware that imagers use.

Downtown Milky Way by Jon Gunning

Telescope Mounts
The foundation of astro-photography is the mount.
An amateur imaging mount has to be equatorial.
In the world of amateur astro-photography the
two statements above are axiomatic. A weak
mounting can deliver good images under perfect
conditions and for some types of imaging one can
get away without an equatorial mount. For most
applications though a strong, well-built equatorial
mount is still optimal.
What is an equatorial mount? An equatorial
mounting allows a telescope to accurately track
the sky as the earth rotates but not all tracking
mounts are equatorial. For an example of a nonequatorial mount think of a camera tripod. Most
camera tripods allow a camera to move so that it
Fig. 1
tilts up and down, and swivels side-to-side. In
astronomy this is known as an altitude-azimuth
(alt-az) mounting system. To track the stars a mounting of this type needs to move both axes in concert
which many do, but these are not optimal for astro-photography (see the panel at the end of this
chapter).
To turn an alt-az mounting into an equatorial mount it needs to be tilted so that the vertical axis is now
parallel to the earths rotational axis (through the poles). The
axis that swivelled parallel to the horizon now moves parallel
to the celestial equator hence the name 'equatorial'. This type
of mounting allows the telescope to track with the rotation of
the earth by only moving a single axis.
Two types of equatorial mounts are most commonly used in
the world of amateur astro-photography; the fork mount and
the German equatorial mount (GEM). Other types such as the
split-yoke and English cross-bar while good designs, have
generally not been widely offered commercially.
Fork mounts look like large tuning forks with the telescope
tube riding between the tines. These were made famous by
Fig. 2
Celestron and Meade, both of whom offered their SchmidtCassegrain telescopes mounted in this fashion. Over the years many thousands of fork-mounted
telescopes have been put to good use in the field.
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Figure 1 on the previous page shows a Meade LX200 owned by Chip Frappier of Manatee, FL. The
fork mount is riding on a structure called an equatorial wedge which tips the mount so that the polar
axis, which is parallel to the fork tines, is in-line with the earth's axis. Equatorial wedges are generally
adjustable for different latitudes and good ones will be very sturdy. The declination axis runs through
the centre of the telescope at the top of the fork arms.
Some fork mounts may have limitations as to where they
can be pointed with a camera attached on a SchmidtCassegrain such as the one shown. Notice that the camera
would have to be able to swing through the forks at some
orientations. This may limit imaging in the area of the
celestial pole. Also, when the telescope is pointed at the
zenith it may be difficult to focus a DSLR camera just
because of the position of the camera with reference to the
tripod.

Fig. 3

While no counterweights are provided with fork-mounted
telescopes some weights may have to be added. As the
optical tube generally cannot be moved in the forks placing
a heavy load on the rear of the telescope may cause
problems in some orientations. Accessory kits can be
purchased to add weights along a bar that runs under the

telescope to balance the load.
One limitation of a fork mount is the length of the forks themselves. They should be short enough to
mitigate any 'ringing' or vibration yet long enough to allow a camera to swing through them as needed.
This means that some thought has to be taken in the design of the forks. Something to be taken into
consideration.
The second type of common mounting is the German
equatorial mount. These are by far the most common mount
types sold to people that have their own optical tube.
German equatorials such as that shown in Figure 3 have a
polar axis that is adjustable for latitude and carry the
declination axis at the north end. The declination axis is set
perpendicular to the polar axis and carries the telescope
mounting system on one end with a counterweight shaft
opposite it. This layout allows for a lot of versatility in the
type and weight of telescope systems that can be carried.

Fig. 4
While GEMs don't have the 'swing through' limitation that fork mounts have they may be limited in
other ways. Owing to the design a telescope tube may come into contact with a tripod leg in some
orientations, generally near the meridian. This forces an evolution known as a meridian flip where the
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mount 'turns over' to put the optics on the opposite side of the mount. Some mounts use software limits
to mitigate this, others use micro-switches which actually stop the mount tracking at or near the
meridian.
Whichever the type in use size does actually matter when it comes to a mount for astro-photography.
The more mass there is in the mounting generally the more stable the mount is; and stability is king.
There is a caveat here; a lot of mass in the weight in the mounts head won't help if the legs of the tripod
or the pier are too light or aren't stiff enough. While some folks can get good output from lightweight
mounts something with a bit more avoirdupois makes life easier.
A simple test for the stability of a telescope mount is the 'thwack test'. Firstly load the mount with ALL
of the gear that it will be carrying for an imaging session except for the camera. Place an eyepiece in
the telescope and focus on a star. Now, while looking at the star, give the optical tube a good smack
with the flat of your hand and count the number of seconds that it takes for the telescope to settle; the
lower the number the better. Of course, if the telescope belongs to someone else be sure to ask
permission first.
The payload capacity of a mount is extremely important but the numbers offered by many
manufacturers can be misleading. Generally they tend to state the most that their mount can carry for
visual observations (and I'd disagree with most of them in that respect anyway) as this allows them to
quote overly large numbers. For most non-premium mounts the rule of thumb is to take the stated
payload capacity and cut it in half. This will give a realistic limit on what the mount can carry for
imaging.
When thinking about a telescope mount always look into the future. Never expect that the equipment
that is on hand now will remain the same down the road. I like to think that the weight of equipment,
even with the same optical tube, will grow by about 50% over time. So if there is 15 kg of equipment to
be carried look for a mount that will (after cutting the number in half) carry 22 kg of payload. That way
a mount can stay in operation a lot longer.
Many mounts these days are equipped with some form of 'goto' system. This means that once the
mount has been told where it is in space-time (location and date/time) it can be configured to allow it to
automatically slew to a selected object, an object which usually resides in a database held in the
telescope's electronics. For imaging 'goto' is not required but it is very useful if trying to image
something that can't be seen in the camera viewfinder or in a finder scope.
The different 'goto' systems offered by each telescope manufacturer all have their own strengths and
weaknesses. Celestron's NexStar system is very user friendly as is the Meade AutoStar system. The
system that Losmandy uses is called Gemini, a third-party system which is also used on several other
makes of mount.
A mount that is to be used for astro-photography should have an auto-guider port. Not many people
take unguided images these days and having a dedicated port to plug an auto-guider into increases the
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flexibility of equipment that can be used. In any case a mount that can be controlled by a computer may
be able to be guided using standard computer control commands without a dedicated port.
Polar alignment is made much simpler if the
mount has some form of polar alignment
telescope such as that shown in Figure 5. These
are generally small refractors that are mounted
inside the polar shaft of the mount and have an
illuminated reticule that, when properly
adjusted, allows a mount to be accurately
aligned with the earth's axis. Some of these are
better than others but none of them will work
unless properly centred in the axis and, for
some, having date/time rings properly setup.
This type of setup is shown to the right.
To help with getting your mount's Goto system
properly setup, almost all telescope mount
Fig. 5
makers now offer some form of GPS unit that
provides the mount with its position and an accurate time source. My Celestron CGE's slews became
much more accurate when I didn't have to enter my own latitude and longitude then use my wristwatch
for the current time. If the mount is going 'on the road' a GPS makes life a lot easier; no more
envelopes with hastily scribbled position information.
The ability to connect a mount to a computer is very nice to have. While I do most of my imaging in
the field where I don't carry a computer I do make extensive use of my laptop during my visits to a
friends house in Indiana. Working from the warmth (or cool depending on season) of his shop makes
life a lot easier during turn of the season sessions. Also, having a fridge full of refreshments and good
music playing makes imaging almost civilized, but I digress.
Even in the field computer control of the mount can be an advantage as there is access to planetarium
software to peruse to find targets which can then be sent to the telescope to slew to. I use star charts at
our dark-sky site, but believe me, it's much nicer looking at the computer display.
Generally, computers 'talk' to mounts using a serial communications protocol. As not many laptops
these days have serial ports, a USB to RS-232 adaptor will be required. Some reports tell us that not all
work with all mounts and laptops. I haven't had this experience but it is always good to check the online forums to see if anyone has had issues with a prospective purchase. The mount and software have
to be using the same communications parameters which will be outlined in the mount's documentation.
At times an old argument pops up as to whether it's better to have servo motors or stepper motors
driving a mount. For those that are unclear on the difference a servo motor is a DC motor that has an
attached encoder of some kind that runs in a control loop. The circuitry monitors the position and speed
of the motor constantly and adjusts things as needed to keep the mount pointed correctly. Stepper
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motors 'pulse' in small, discrete values such as 1.8 degrees per step; or 200 steps per revolution. For
these the mount's circuitry calculates how many steps per second it needs to turn to track and sends the
correctly timed pulses to the motor. To slew the mount the electronics calculates how many steps are
needed to perform the slew correctly and then sends that number of pulses to the motor. While it may
seem that a mount that 'steps' might be choppy, a stepper motor can run in ½ step mode or can be
micro-stepped to the point where they are as smooth as DC motors. Some high-end imaging mounts
use steppers (notably Takahashi) where others use servo-motors. If the circuitry is designed well it
doesn't matter.
Why do I need an equatorial mount?
With all of the alt-azimuth mounts on the market that can very accurately track the sky why is an
equatorially mounted telescope necessary? The answer is short and is known as 'field rotation'. Any
mount that does not have an axis accurately aligned with the earth's axis will have a field of view that
rotates. For astro-photographers their image will actually rotate around their guide-star.
Field rotation exists because the optical tube on an alt-az mount doesn't rotate in sync with the sky as it
wheels overhead. The graphics tell the tale. The blue cross hairs would be on a polar-aligned
equatorially mounted telescope and the red cross hairs from a tracking alt-azimuth mounted telescope.

While large, professional scopes these days ride mostly on alt-azimuth mounts they also incorporate
some very high-tech and accurate method of rotating their imaging platform to negate the rotation
imparted by the mount. Amateur field de-rotators do exist but they generally don't work very well and
an equatorial platform is always the best choice.
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Tripods and Piers
Some telescope mount manufacturers or vendors offer a choice of
either a tripod or a portable pier. Which is better is a function of the
primary use of the mount. Will it be placed in a semi-permanent
setting such as a roll-off roof observatory or SkyPod or will it
primarily have to be transported to a dark-sky site for use?
For the semi-permanent setup a portable would be quite acceptable
as long as it is properly designed and that design carried out
correctly. The Astro-Physics pier shown in Figure 6. is a very good
pier, properly braced and very stiff. The only thing lacking in my
mind is some method of levelling it on uneven ground. Not being
designed to be hauled around this is not a huge problem, but it is
something to think about if a setup is going to be mobile at any
time.
Fig. 6
Tripods are, in my estimation, are a much better choice for an
imaging setup that is going to move from site to site. Most offer a great deal of adjustment for level on
unprepared ground and are very easy to site for proper orientation.
A properly braced and tensioned tripod is as stable as most portable piers and much more stable than
some. A tripod should, when setup and tensioned, act as a single, monolithic structure. The better ones
have two sets of braces spaced vertically. One of these will push outward evenly on the tripod legs and
the second will pull inwards against the push of the other. These effectively pre-load the tripod so that it
becomes extremely rigid. Figure 7 represents the CGE tripod which is one of the best designs that I've
seen. The brace and spreader are seen with red arrows showing the forces created.
Tripods come with legs fabricated from many
different alloys, composite materials or wood. For
heavy loads, cold-rolled steel is the best in my
opinion. These offer a lot of mass, rigidity and
strength and don't become brittle if being used in
extremely cold temperatures. Wood is very good for a
light or medium duty tripod if the wood is properly
selected. Species like oak or mahogany are strong and
offer very good damping characteristics. I would stay
away from aluminum if only for the lack of suitable
mass for an imaging tripod.

Fig. 7
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With the amount of gear that tends to be used while imaging
some sort of shelf or platform is almost de rigueur and several
companies offer a replacement spreader for tripods that also act
as accessory shelves. One of the best I've seen (Figure 8) is
made for the CGE and was offered by Starizona. They have
sadly discontinued this product but one of the denizens of the
CGE Yahoo! group has taken up building these in his shop.
Another very good accessory that should be part of any imager's
kit is a lower accessory tray. These can come with or without a
spreader and Telescope Performance Improvements offers a
wonderful unit that will fit most Celestron, Meade, and
SkyWatcher/Orion mounts. As seen in Figure 9 they are perfect
for keeping a battery off the ground.

Fig. 8

Many tripods come with pointed ends on the legs, or they
have plastic or rubber covered 'knobs' on the end. On
unprepared ground these can slowly dig in during an
imaging session causing drift in the images. A simple way to
remedy this is to carry a few bits of plywood that can be laid
on the ground underneath the tripod feet. Some ingenuity of
design might be needed to keep the legs from from sliding
on the wood and the wood sliding on the ground.
Another method of keeping the legs from digging in would
be to use a set of the anti-vibration 'pucks' that are sold by
Celestron, Meade and Orion. These go under the tripod legs
and will keep them from digging in though I really wonder
if the flexibility designed into these could create any issues.
Fig. 9

The last thing I will mention about tripods is Velcro. There
can never be enough places to hang things like flashlights,
intervalometers, USB hubs etc. and Velcro is perfect. I put squares of industrial strength Velcro on just
about every flat surface on my mount and at least two on each tripod leg.
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Gears and Periodic Error
Most modern mounts use a worm-andgear (also called worm-and-wheel)
type of drive on each axis. These allow
for a full 360-degrees of rotation and
non-reversibility of drive along with a
great amount of gear reduction.
The reduction in a worm and gear
drive is the number of teeth in the gear.
A 360-tooth gear will show 1:360
reduction while a 180-tooth gear will
have a reduction of 1:180. Like the
transmission of a car in low gear motor
torque is greatly multiplied allowing a
Fig. 10
small motor to easily turn a large and
heavy telescope. Also, telescope has to
track the sky accurately at approximately one revolution per day. A motor could not turn accurately at
that slow a speed so the large amount of reduction in a worm drive also allows the motor to turn at a
usable speed.
Figure 10 shows the worm and gear setup from a Mathis Instruments mount. The worm is the small
driving gear and the worm-gear is the large bronze driven gear. Due to the non-reversibility of the
gears.the worm-gear cannot drive the worm which is perfect for telescope use. This means that when
the drive is stopped, even an out-of-balance condition will not cause the axis to slip.

Fig. 11
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A favourite discussion in the on-line forums is the topic of periodic error (PE). PE is a tracking error
caused by slight inaccuracies in the mount's RA worm which can make the mount speed up and slow
down very slightly. This causes a target to 'wobble' back and forth in right ascension as shown in Figure
11. Different samples of similar mounts from a single manufacturer may show differing PE.
PE can be caused by many different types of inaccuracies in the worm. Figure 12 shows two worms
that have machining errors compared to one that is perfect (left graphic). The centre worm itself is
round but is being driven off centre which will cause it to strike the gear alternatively closer and further
from the centre of the gear's rotation. The graphic on the right is a worm which is out-of-round, or eggshaped.

Fig. 12
Both of these types machining errors will cause the mount's RA axis to speed up and slow down
alternately with the period of the worm and could generate a PE curve such as in that in Figure 12.
A greater problem is a worm that is 'bumpy' as is shown in Figure 13. The left hand graphic shows a
smooth worm (red) striking the gear (black). As the worm turns it will turn the gear smoothly. The right
side of the graphic shows a poorly polished or
lapped worm striking the gear. This will cause the
gear to jerk quickly while turning, either speeding
up or slowing down rapidly with a period much
shorter than a full worm rotation.
Figure 14 shows the actual PE curve of a modern
popular GEM with a peak-to-valley amplitude of
about 26 arcseconds. This sounds like a lot but is
not unheard of with today's telescopes. The PE
curve is superimposed by a perfect sine curve
which shows that the mount's gears are quite Fig. 13
smooth. The spikes are due to seeing.
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The important thing in the graph is not
the amount of PE but that the curve
almost perfectly matches the sine
curve. On this mount an auto-guider
will be able to correct any drift in a
guide-star perfectly.
To show how bad a modern mount can
be is the PE curve displayed in Figure
15. This is also from a popular mount
that is touted by the manufacturer as
being well-suited for imaging. Over
this mount's PE curve I have tried to fit
a sine curve but this was not as simple
a task as in the previous example. This
mount would not be very useful for
imaging without some work.

Fig. 14

Today just about everyone is guiding their images so normally any PE will be guided out. The amount
(amplitude of the PE curve) of PE isn't generally an issue but more important is the shape of the curve.
Figure 15 shows many areas where the curve is so steep that an auto-guider may not be able to correct
for the changes quickly enough.
Even if it displays a bad PE curve like Figure 15 a mount may still be usable for imaging. Most mounts
these days come with some form of periodic error correction (PEC) built into their firmware. PEC has
always been a rather dark art to me and I never really did get it to work properly on my HEQ5. I don't
even try on my CGE as it isn't needed. The theory of how PEC works is quite simple. Start the mount's
PEC 'learn' routine and let the mount
run over three or four worm
revolutions (see calculation below)
while guiding on a star. While in
learning mode, the PEC system records
any guiding done. Once stored, the
PEC system is turned onto 'playback'
and any guiding that was recorded is
used by the mount's firmware,
speeding up and slowing down as
needed to smooth out the curve.
There may be an problem using PEC
while auto-guiding in that the guider,
during its calibration phase, is doing its
calculations with no knowledge of any
worm rotation speed changes. If the

Fig. 15
14

mount is being guided during times of very slow or very fast worm rotation, as dictated by the PEC
routines, then guider error could be introduced. This may or may not be an issue and SBIG has in the
past stated that PEC should be turned off when using their guiders.
So how good is PEC? Generally quite good
from the examples I've seen where people
have taken their time and used the available
software tools correctly. With very good
mounts PEC can reduce error to the point
where an auto guider isn't needed for
short(ish) exposures making the system good
for survey or patrol duties. Generally it's not
good enough for long-exposure imaging with
any mounts that normal humans can afford.
There are several tools available to help with
both determining the amount of PE a mount
exhibits and to help with the mount's PEC
Fig. 16
routines to smooth it out. If the plan is to use
both PEC and an auto guider it would be in their best interest to check the on-line forums to see if there
will be any issues.
Figure 16 shows a Fourier analysis of Figure 14 curve. A Fourier analysis determines all of the sine
curves that, when added up, generate the curve being analyzed. These individual sine curves show up
as 'spikes' in the graph with the centre of the spike being the period of that curve. This type of chart
shows the PE generated by all of the gears between the motor and the worm-gear individually. As can
be seen in the graph, the analysis of the Figure 14 curve shows really only two periods, that of the
worm at about 480 seconds and a smaller curve at about 150 seconds which is probably due to some
error in the transfer gears between the motor and worm.
Figure 17 shows a typical worm-andgear setup. Places were PE shows up
are in the worm and gear, the transfer
gears and in the gearbox of the motor.
Errors generated in the gearbox usually
show up as the 'noise' at the far left of
the Fourier analysis graph. Normally,
PE from the gearbox and transfer gears
do not have a deleterious effect on
tracking, but very bad transfer gears
may. Fixing transfer gear PE could be
difficult. Dirty or sticky bearings in the
worm's shaft may also add to the noise
in the Fourier analysis.
Fig. 17
15

Calculating worm period
A PE curve will have an amplitude equal to the greatest excursion of the star from centre and a period
of which can be calculated thusly:
86164 / number of teeth in the worm gear
So, a gear with 180 teeth will have a worm period of 479 seconds while a gear with 360 teeth will have
a period of 239 seconds. A telescope mount's documentation will generally tell both how many teeth
are on the worm gear and possibly the average PE the manufacturer puts on that mount.

Patrick Whelan of London took this image with his Canon XT through the trees
using a tripod and the 18-55 mm kit lens.
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Optics and Optical Tubes
Optics is a subject I hate giving any advice on as it is akin to religion or politics. The 'refractor vs
reflector' wars rage unabated on many astronomy forums and they probably always will. Here goes.
Optics have come a long way since I started out in this astronomy addiction. Today there are literally
dozens of good and reasonably priced telescopes on the market that would do admirably as astrographs. For wide fields there are short-focus apochromatic refractors from many manufacturers and
even what once were exotic reflective systems such as the Ritchey-Chretien type are being sold at
prices most can afford.
Optical systems generally come in three types. Refractors, those telescopes that use a lens or several
lenses to form an image; reflectors which use a mirror or mirrors to do this and the hybrid catadioptric
systems that use a mixture of both. Which is 'best' depends on what is to be imaged and how much
abuse ones pocketbook can handle. Let's have a look at them.

Refractors
As mentioned above refracting telescopes use a lens
system to focus light. The simplest would be those such
as Galileo first used to look at the Moon and consist of a
single lens objective in the front and a single lens
eyepiece at the rear. Simple but not much good for
capturing any images.
Refractors generally have smaller light grasp than any of
the others only for the fact that middle-aperture (8”)
Fig. 18
lenses are prohibitively expensive and anything larger
becomes unwieldy. Most of today's refractors being sold have apertures between 80 and 150 mm (3.1
to 5 inches).
It is my opinion the new small-aperture refractors are the best of the portable astrographs. If ones idea
of refractors stems from the days of Unitron's beautiful doublets that stretched out to f/15 or beyond
they will almost find it hard to recognize today's offerings. Short f/4 to f/8 tubes that fill dazzlingly
wide fields with diamond-dust stars are the norm now. The glass in these telescopes comes in the form
of doublets, triplets and Petzvals (4-element) and more are gracing mounts around the world than ever
in the past; and turning out images that are stunning.
Most modern objective lens systems are well corrected for spherical aberration and coma. The many
ED doublets are also well corrected for secondary spectrum (false colour) and today's apochromatic
objectives will show no false colour at all. The one aberration these telescopes will show is curvature of
field. Most refractor vendors also offer a field flattener to correct this, usually combined with a focal
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reducer. The focal reducer function just gives the optics a wider field of view (see section on flatteners
and reducers)..
Refractors, having nothing impinging on the incoming light, do not show the cross shaped diffraction
spikes that other telescopes exhibit near bright stars. Also, having no central obstruction, refractors
provide the highest contrast images of all astrographs.
Having a lens at the front of the tube means that refractors are susceptible to dew. To combat this and to
ward off stray light most have a long shield that protects the objective lens from seeing too much sky.
This can slow the development of dew but won't stave it off forever. Active dew control has to be taken
into account with all refractors that are used in humid conditions. A refractor's closed tube means that
tube currents are generally not an issue and with the objective out front the glass cools quickly.
Today's refractors come in three classes, achromatic, ED doublets and apochromatic with several types
of apochromats. I include ED doublets as a separate class from 'apos'. This is one of my pet peeves as
just about every maker of a doublet (two element) refractor with a piece of extra-low-dispersion (ED)
glass in it is calls their offering 'apochromatic'. There being no laws against telescope makers doing this
the unwary purchaser can be taken in. While a properly designed doublet can indeed be apochromatic
most aren't. Honest makers will just call them 'ED
Doublets' and not apos.
Different types of refractors have lens systems designed
and built generally to meet two criteria; firstly to reduce
secondary spectrum (chromatic aberration) and secondly
to provide increased flat field of view.

Fig. 19

Fig. 20

Chromatic aberration (CA), Figure 20, is caused by light
of different wavelengths of light to come to a different
focus. This means that the edges of bright objects show
'fringes' of colour.
In order to fight CA the achromatic doublet, Figure 21,
was invented. This used two glasses of different
refractive and dispersive properties, known as crown
and flint, to allow the light of two widely spaced
wavelengths to come to a single focus. This greatly
reduced the fringing. With a standard achromatic
doublet the shorter the focal length (hence wider field)
the greater the effects of CA. In the past achromatic
refractors had focal ratios of around f/15 in order to
reduce CA even further.
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While several designs of achromatic doublet came into existence in the early years of astronomical
telescopes, the design of Fraunhofer is the most common now.
The Fraunhofer doublet has a front element of crown glass and a rear element of flint glass with an
airspace in between them. The curves are all spherical but of different radii in order to fight ghost
images. Other makers played with the Fraunhofer increasing the airspace (Clark) or even reducing the
airspace or filling it with an optical quality oil.
To
minimize
chromatic
aberration achromatic refractors
should be at a focal ratio of f/10
or greater but this doesn't mean
that a short tube refractor can't
take stunning images. Some
very good f/6 or f/7 achromats do
exist though they can't get away
from the 'blue goo' of fringing
around any brightish stars. Use
them with a minus-violet filter to
reduce this effect. Figure 22 was
taken with an unmodified camera
through a Stellarvue Nighthawk
II 80 mm f/6 achromat.
An offshoot of the standard
achromatic doublet is the 'ED
doublet' offered by many manufacturers and sometimes marketed as 'apochromatic'. These use
carefully designed lenses with the front element being made of one of the extra low dispersion glasses
matched with a proper flint ( rear element) to reduce CA to very low levels. I challenge any of the less
expensive ED doublets to meet either Abbe's or Back's criteria. My Stellarvue SV102ED which would
be called apochromatic by most makers is called only an ED Doublet by Stellarvue who also makes
true apochromatic refractors (triplets usually).
Fig. 21

Abbe defined apochromatism as follows:
An apochromatic objective will be corrected parfocally
for three widely spaced wavelengths and corrected for
spherical aberration and coma for two widely separated
wavelengths.

Fig. 22

Any refractor that meets these criteria will show no
secondary spectrum or 'false colour' when observing or
imaging bright objects. The late Thomas Back expanded on
this once in a paper basically saying that any optical system
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that met stringent image quality criteria could truthfully be called 'apochromatic'... his criteria were a
bit different than Abbe's but basically said 'no false colour'.
The first commercial apochromatic triplet was designed and built by John Dollond of London in 1763.
Using three elements allowed the optician to have two colour crossings and therefore bring three
widely spaced wavelengths of light to a single focus. Modern triplets show almost no false colour. The
triplet shown at the left is of the Dollond (later called Cooke) design.
Using three lenses allows a great flexibility of design for the optician and these can be of very fast focal
ratio providing a large well-corrected field.
Modern triplets all use some form of extra-low dispersion centre element such as FPL-53 or an
equivalent; or possibly an element of
calcium fluorite. The availability of exotic
glasses these days has provided for some
truly stunning images.
The last apochromatic type that is becoming
more common, in that several makers offer
them, is the Petzval type. This type of
telescope uses two doublets very widely
spaced; often at opposite ends of the tube.
The front element in the best will be an
Fig. 23
apochromatic doublet (they do exist, usually
with a fluorite element) with a focal length in the f/10 to f/15 range and the rear doublet which may or
may not use exotic glass will decrease the total focal length to the f/4 to f/5 range. The Takahashi 'Q'
types are of this style.
Refractors display other aberrations such as coma, spherical aberration and curvature of field. Very well
designed refractive systems can reduce or eradicate most of these to a high degree. The major detriment
of refractors is the very high dollar per inch aperture. A good 100 mm refractor can cost more than a
good 400 mm Newtonian reflector.

Reflectors
Reflecting optical systems use curved mirrors to focus light instead of the curved glass lenses of the
refractor. These have many advantages over refractive systems and some detriments. The biggest
advantages that reflective systems can have are the cost per inch of aperture and the lack of chromatic
and spherical aberration. Reflective systems focus all light to a common point and, having no spherical
elements, do not show spherical aberration; but they are all not perfect.
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Newtonian reflectors
In the world of mirrors we can split the discussion into two sub-topics: the Newtonian and the
Cassegrain (of all types).
Newtonian telescopes have been around a long time
(Sir Isaac invented them) and generally consist of a
parabolic primary mirror which reflects light up to an
angled flat mirror which then directs it out of the side
of the tube. These are very simple and yet very
efficient.

Fig. 24

Inch for inch of aperture Newtonian telescopes are
generally the cheapest of any of the telescopes on the
market today. Optical tubes of 8” of aperture only run
a few hundred dollars and specialty astrographic
Newtonians can still cost less than $500.

With no spherical elements the proper Newtonian reflector's worst attribute is that it does display an
off-axis aberration known as coma. This is due to it's parabolic primary mirror and makes the stars
towards the edge of the field look like little seagulls instead of pinpoints. The effect starts close to the
optical centre and worsens the closer one gets to the edge of the field. The use of an additional lens
called a coma corrector will correct this. The faster the optical system the more prevalent coma is. As
most Newtonians work in the range of f/4 to f/6 range all will need some correction. Most coma
correctors only work down to f/4 while some specialized scopes work as fast as f/2.8 These most
probably have a coma corrector shipped along with them or built in.
Newtonian reflectors, with their primary mirror at the bottom of a long tube are generally not
susceptible to dewing up though they are susceptible to tube-currents. Giving the primary mirror
enough time to cool to ambient temperature is necessary. Some telescopes have cooling fans installed
to help with this. Some Newtonian reflectors are of an open tube design and in this case the primary
mirror may need some anti-dew protection.

Cassegrain reflectors
Cassegrain reflectors come in several 'flavours' from
the classical Cassegrain to the Ritchey-Chretien and
Dall-Kirkham. The differences between all of these
are just in the type of curve used in the two mirrors
that comprise the optical system: a concave primary
and a convex secondary. The different curves used
in the mirrors are all designed to fix coma or some
Fig. 25
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other aberration such as curvature of field. A design called a Corrected Dall-Kirkham will also have a
lens-set in the focuser to help its mirrors along.
All of the Cassegrain telescopes have a hole in the centre of the main mirror. This is to allow the light
cone to exit the telescope. Unlike the Newtonian the Cassegrain's secondary mirror does not reflect the
light out the side, but back towards the main mirror. All of the various designs allow a long focal length
to fit into a compact tube. The hole in the primary mirror has no effect on the image as it is masked by
the secondary mirror.
The classical Cassegrain telescope has a parabolic main mirror and an hyperbolic convex secondary
mirror (some have elliptical secondaries). The usable field of view is generally fairly small. Classical
Cassegrains suffer from coma due to the parabolic primary along with fairly slow focal ratios, generally
f/10 and higher.
The Ritchey-Chretien design uses a hyperbolic primary and hyperbolic secondary to reduce the coma
inherent in the classical Cassegrain. They display curvature of field but have a large useful field of
view. All of the large research telescopes made after the 200 inch Hale telescope are of the RitcheyChretien design. They are the favourite of well-funded amateurs and can work well in the f/9 range.
The Dall-Kirkham design has a parabolic primary mirror and a spherical secondary mirror. Coma is
greater than the classical Cassegrain so most D-K telescopes operate at f/15 or greater, where the coma
is minimized. This makes them rather unsuitable for larger area objects. A newcomer to the field known
as the Corrected Dall-Kirkham, such as those offered by Planewave, can work at f/8 or even faster and
makes use of a multi-element corrector lens ahead of the focal plane to reduce aberrations and deliver a
large field of view.
The rage these days is for Ritchey-Chretien designs which incorporate previously hard to make
hyperbolic mirrors. Up until lately R-C telescopes have run in the $2000/inch aperture range which has
priced them out of most people's budgets. But GSO of Taiwan has broken the price barrier offering 6, 8
and 10 inch R-C scopes for as little as $299. From all reports they are very good. These boast quartz
mirrors, carbon-fibre tubes etc. A slightly less expensive version is offered by Orion in steel tubes.
Cassegrain reflectors of any type generally have a 'spider' holding the secondary mirror in place which
causes diffraction spikes around bright stars. Those that use a solid tube are generally not susceptible
to dewing up though the secondary may need some protection if it is far enough forward in the tube.
The primary in Cassegrain telescopes with an open truss design may also need some dew protection.
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Catadioptric reflectors

Fig. 26
The last telescope design to discuss is the catadioptric type which are most commonly of the SchmidtCassegrain or Maksutov-Cassegrain design. There are some Schmidt and Maksutov Newtonian
telescopes available that are very good, they're just not as common. These all incorporate a spherical
primary mirror and some form of corrector plate (lens) at the front. The corrector is used to modify the
incoming wave-front so as to reduce the spherical aberration caused by the primary mirror.
The Schmidt design uses a thin lens with a complex toroidal curve while the Maksutov uses a thick
meniscus lens with spherical curves. Both work very well and like the Cassegrain designs discussed
above are very compact. Schmidt-Cassegrains generally operate around f/10 while Maksutov designs
work around f/14.
Schmidt-Cassegrain telescopes from Celestron and Meade are probably
the most prevalent middle aperture telescopes around. The 'classic' SCT
is a compromise; the Schmidt design called for the corrector plate to be
at 2 focal lengths from the primary mirror whereas current SCTs have
the corrector inside the focal length of the primary.
A new design from Meade known as Advanced Coma Free (ACF) uses a
different shaped corrector plate which makes the wavefront leaving the
primary think that it was reflected from a hyperbola. That and a
hyperbolic secondary caused Meade to originally market them as some
form of Ritchey-Chretien which drew bad press from just about
everyone.

Fig. 27

Celestron has countered Meade's ACF with its High Definition (HD) systems. These use a built-in
correcting lens to flatten the field and reduce coma. The biggest problem with this is that the focal
reducer/field flatteners they sell for their standard SCTs (Figure 28) won't work with the new optical
designs. Whether the optical system is of the ACF, HD or standard design a focal reducer is almost
mandatory with any SCT as operate in the f/10 range and therefore are very slow and have a narrow
field of view.
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Because of the corrector plate at the front of the tube most catadioptric telescopes require some form of
dew control (discussed later).
To offer some advice as to which of all mentioned (and others) is the best optical system to use for
imaging would be doing a disservice to a lot of telescope makers. Every optical system has its strengths
and weaknesses. Looking for that perfect compromise between enough focal length for planetary
imaging and wide enough field for extended nebulae just isn't going to come to pass. In the past the
wisdom was that the 8” SCT was the best 'all purpose' telescope but then, there weren't a lot of imagers
around. Now, to cover all bases, two or even three optical tubes might be needed.
The best starting point in the search for an imaging telescope is to take the widest field the tube needs
to deliver with a chosen sensor. This is fairly easy to do with a scientific calculator. The equation for
field of view is:

2 * Atan(field) = .5 * (sensor width/focal length)
What is needed is to plug in is the field and the sensor width and get a focal length and to do this the
equation is going to have to be worked backwards.

focal length = sensor width/tan( field )
Take a calculator and enter the desired field in degrees. Then press the TAN key and divide the result
by the width of the sensor and press the 1/x key. Out spits a focal length and THAT is the starting
point. For example; I have a camera with a 22 mm wide sensor and I want to be able to image a 2
degree field. I open up my hand calculator application and enter:
Enter 2 then press TAN
Press / and enter 22
then press 1/x

=
=
=

0.03492076949174772692
0.001587307704170351224
629.9975722241433427

In this example I need a 630 mm scope to deliver the 2 degree field of view I want
Here is a simple word of wisdom no matter what type of telescope. It's simpler, cheaper and more
effective to turn an f/5 optical system into an f/10 system than it is to do the opposite. If it is desired to
shoot both extended objects and small stuff like planetary nebulae (or planets) then opt for the faster
optical system and a good Barlow to stretch out the focal length, or better yet a TeleVue PowerMate

Coatings
All modern refractors use 'multi-coated' lenses. The coatings used are materials that have a different
refractive index from the substrate of the lens and are used to control or minimize reflection or to
enhance reflection; depending on the optical device. Most lens coatings are of the kind that minimize
reflection which can cause both a loss of light and unwanted 'ghosts' showing up as light reflects
between the components of a multi-lens objective.
24

The mirrors of reflectors can be coated with one of several grades of aluminum or, for special
applications, gold, silver or other metal. Aluminum coatings reflect ~88% of the light that impinges
upon them. Enhanced aluminum coatings are formulated to reflect ~92% and the new dielectric
coatings on some mirrors can reflect greater than 97%. While this sounds like a large jump remember
that imagers collect light over time. With only standard aluminum coatings just take an extra sub-image
to make up the few percent lost over enhanced or dielectric.
Normally these days the reflective coating of a mirror is protected by a transparent layer of material
such as magnesium fluoride or other formulation which can keep an aluminum coating bright for many
years.

Tube composition
Telescope tubes are made from all kinds of things from wood, plastic through steel and carbon fibre.
While some makers offer a choice most scopes come with one type of tube and each type has its pros
and cons. A quick comparison follows with no attempt to select better or best.
The latest trend in optical tubes seems to be carbon fibre which is thermally stable, lightweight and
strong. The trade off with this is that the tubes are generally more expensive, need different lens or
mirror cells and (the jury is out) possibly don't transfer heat from anti-dew strips as well as steel or
aluminum.
Steel tubes are more stable than aluminum and less expensive though they are heavier. They transfer
heat well. Most small refractors sport steel tubes.
Aluminum tubes are as strong as steel but about a third the weight. The transfer heat extremely well.
Open truss telescopes (generally ½ of a Serrurier truss) are generally seen in larger reflecting telescopes
with some offering full Serrurier trusses. These are lightweight, mechanically stiff but complex and
expensive.

Tube baffles
Optical tube baffles, especially in refractors, can cut down greatly on unwanted light getting through to
the sensor. Well designed baffles with sharp edges (knife-edge) will cut down on this extra light
without adding any sensible reflections of their own. They should be designed and placed so that all of
the available light is passed without vignetting.
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Fig. 28
Some reflectors do carry baffles, mostly from higher-end vendors though plastic baffling systems are
showing up in entry-level tubes. Baffled or not, an optical tube should be properly blackened on the
inside to minimize reflections.

So what is this ED glass everyone is touting?
An achromatic double is a lens that has two elements; a front element of crown glass and a rear
element of flint glass. Together they reduce the chromatic aberration in an optical system. In the hunt
for better lenses Ernst Abbe, an employee in the optical firm of Zeiss discovered that he could reduce
chromatic aberration to almost nothing by using a front element made of natural crystals of fluorites.
For years that is what high-end (read expensive) objectives used.
Fluorite is fragile, very expensive and not available in large blanks so any fluorite objectives were
usually fairly small. Glass makers, always looking for a better way started discovering formulations of
glass that could match the dispersive properties of fluorite for less cost and the latest widely used glass
for this purpose is the magical FPL-53 which has an Abbe number (measure of dispersion) close to
fluorite.
Of course, the glass isn't really magical and won't do a darned thing without the right mating element
(the flint element) for it and a good design. But if you are a refractor maker and can't put 'FPL-53' in
your press copy somewhere you'll probably go broke.
Do we need FPL-53? No. There are other ED glasses that, mated with a proper flint, will do as well.
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Ryan Fraser shot this wide-angle image of the Coat Hanger
asterism from a Purus-Astromechanik tracker with a Canon XT and
50 mm lens.
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Mounting Rings and Dovetail Bars
All telescopes need some way of being
attached to a mount. The most common
method for larger scopes is a set of rings
while some smaller scopes may come with
some form of clamshell. Much larger scopes
might use a method of bolting them directly
to a plate on the mount.
Rings come in three forms, split rings, solid
rings, and rotating rings. The split rings are
easy to place on and remove from a telescope
as they come apart. One side will have a
hinge and the other will have some method of
clamping the two halves together. Rings run
the whole gamut from very inexpensive to very pricey with just about everything in between.

Fig. 29

The rings shown in Figure 30 are a good example of inexpensive split rings. These are available from
Orion Telescopes and Binoculars for just about any tube diameter desired. As can be seen, there is a flat
on the bottom of each to allow the attachment of a dovetail bar and a flat opposite that can have an
accessory bar mounted, or something like a camera piggy-back mount.
Solid rings are usually relegated to holding finder and guide scopes and have some method of adjusting
the position of the scope in the rings to align them (see below).
Rotating rings such as those from Parallax
Instruments (Figure 31) are much more complex
and and therefore much more expensive. These
generally have two sets of nested rings, one of
which fits the tube and the other which rotates
allowing the tube to rotate. To be of any use in
astro-photography they must have a fool-proof
method of locking in place. Having the rings
rotate, even slightly, during a session would ruin
the exposures. To put rotating rings on an optical
tube usually means removing everything from the
tube, installing the rings and then re-installing
focusers etc.
Fig. 30
Clamshell mounts are generally hinged and are
made available with many smaller telescopes. The part shown in Figure 32 is from Stellarvue and is
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offered with several of their models. They attatch to a mount with a built-in Vixen style dovetail bar
which can be seen on the bottom of the clamshell.
I use three optical tubes (two for imaging and one for guiding) and each
has a different style of ring. My two imaging scopes, a refractor and a
reflector, both have split rings. One has a heavy machined set and the
other has a set somewhat like those from Orion shown above. The guidescope has a set of solid rings with adjustment.

Fig. 31

I've found that even the inexpensive split rings hold my telescope nicely
though I would like something heavier some day. The problem with
machined rings is that the cost doesn't scale linearly as size goes up. A
set of machined rings for the 8” astrograph would not be just double the
price of the ones on my 4” refractor.

The solid rings that I use for my guide scope came from Ken's Rings in
the US and are quite inexpensive. They come painted instead of anodized, which means that the colour
doesn't last long, but then I didn't buy them for beauty. The also don't have a standard dovetail system
(which is fine). To put accessory bars that fit the rings on all my tubes just took some scrap aluminum
and a bit of machining.
Along with the rings that hold the optical tube will be a dovetail bar of some type to hold the whole
thing to a mount. These days there are two types which are generally available for any desired optical
tube. These are the Vixen style and the Losmandy style.
The Vixen type of dovetail bar (Figure 32 left side) is 1 and 7/8 inches wide and is held to the rings or
(for Schmidt-Cassegrains) screwed to the front and rear cells. Most are of extruded aluminum but some
manufacturers (such as Ken's Rings) offer solid machined bars. The Losmandy type shown in Figure 32
(right side) has a cross-section of 3 inches and is held to a tube the same way as the Vixen type.
Is either type of dovetail
system any better than the
other? I'm sceptical. A piece of
metal screwed to another piece
of metal doesn't move, whether
it's two inches across or three.
Now, if I had very large or
heavy scopes I'd probably opt
for the Losmandy type; for no
reason other than they're a
closer match to the scope size.
Adaptors to mix and match are
available from ADM.
Fig. 32
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Jon Gunning shot the heart nebula with a Pentax 100 EDUF astrograph and
SBIG ST-10XME camera in hydrogen-alpha. All mounted on an Astro-Physics
1200GTO mount.
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Electrical Power
Something that can't be ignored when taking up imaging is the need for power. Imaging from a
permanent setup has different, and generally simpler, requirements than imaging from a rig that moves
around.
The most common (almost ubiquitous) power source that is found in the ranks of imagers in the field is
the 12 V automotive battery or some other 12 V source. These can be anything from a small,
lightweight piece of equipment such as the Celestron PowerTank, which is really designed for visual
observers to power a smaller mount for a nights observing, to a complex, multi-battery setup that only
pays lip service to the word 'portable'. To determine what exactly is needed the following questions
need to be answered:
How much current does my equipment draw?
How long do I want to power my equipment?
The first question is easily answered by the judicious use of a multi-meter or ammeter. To do this first
provide some power source for the gear to run off of; either a regulated DC supply plugged into the
wall or a battery. Place an ammeter or multi-meter in-line on either positive or negative (with the leads
'pointing' the right way) then setup and plug in your mount with ALL of the equipment that has to be
run. Turn it on and read the ammeter. That is the MINIMUM current requirement.
A power source has to have a large enough capacity to be able to power all of the equipment for
whatever is the desired number of hours or imaging sessions. Battery capacity is measured in amperehours and is the amount of time that a one ampere load can be maintained before the battery voltage
drops to a specified point. All batteries have their capacity listed. Let's consider that a night of imaging
is eight hours long. If the gear draws 2.5 amperes as measured then a power source that can provide a
minimum of 20 amp-hours will be needed. I like a 50% cushion myself so I would use a 33 Ah battery.
These as can be purchased at an outlet like Canadian Tire in several forms.
Simple power packs can provide enough power for a telescope and peripherals but if a computer is
required in the field then that 33 Ah booster pack won't cut it. In this case a pair of deep-cycle marine
or RV batteries connected in parallel may be needed. I generally split my gear between my portable
battery, which powers my guider, camera etc., and my car's battery which powers my mount.
Some thought has to be given to how the gear will be connected to the power supply. While most come
with the ubiquitous cigarette-type plug these are about the worst connectors in use. They were designed
to heat up a lighter, not to hold a connector for a critical imaging session. I prefer banana plugs while
some prefer RCA plugs though these were not designed to handle current so be wary of them. Binding
posts are the best method, but not as common. Avoid phone style plugs as these short on plugging or
unplugging.
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To get the power from the battery pack to your equipment requires wire of the correct gauge. While
electrons will flow over any wire when passing current over long distances the gauge of the wire is
important. Stay away from coaxial cable as it was not designed for power transmission. Any good two
conductor wire of 16 gauge will suffice for long runs while 20 gauge can be used for shorter runs
(larger numbers means smaller wire) with lower current.
Wire gauge

Diameter (mm)

Resistance (ohms/km) Current rating (Amps)

16

.129

13.18

3.700

18

.102

20.95

2.300

20

.081

33.30

1.500

22

.064

52.95

0.920

24

.051

84.22

0.577

As can be seen from the above table a lot of current can't be pushed through a small wire. The current
ratings above are very conservative and are sure to be safe. Do keep in mind that the longer the run of
wire the more the voltage will drop just by pulling the current through that wire.
Shown in Figure 33 is a (sadly discontinued) Nautilus Marine Booster Pack from Canadian Tire. This is
a 33Ah unit that has an absorbed glass mat battery (no spill) that can be 'deep cycled' nicely. It's not
overly heavy and provides all of the power that I need for a single night session.
Booster packs such as the Nautilus come with two methods of getting the power out; a cigarette lighter
plug and a pair of binding posts. I've found that the cigarette lighter plugs found on these are rather
poor quality and as a lot of gear use these types of plugs a triple or even quad plug may be needed.
The second source are heavy-duty binding posts
which are designed for booster cables and the like.
The Nautilus shown has a rotary switch that allows
the binding posts to be turned on and off which is a
nice feature. If adding plugs connect them to the
binding posts or wire them internally with wire of a
proper gauge.
Once power has gotten to the mount it will probably
have to go to several places in order to be useful.
These might be to power a dew heater, a camera, a
USB hub or other devices. Once the power is up to the
mount I prefer using RCA plugs to connect things and
have a 'power distribution box' to split the 12 V
coming in out to my stuff. It also doubles as the 12 V
terminus for my anti-dew heaters and I provide RCA
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Fig. 33

plugs for 3 heaters and 3 12 V sources. I think that if I was building it anew I would go with 5 or 6 12
V sources.
I don't power my mount through the 12 V distribution box. As I mentioned I usually plug the mount
into my car and let the booster pack power everything else. If the car isn't close enough then I'll plug
the mount directly into the battery. This means that I'm not using one of the limited number of 12V
ports on the distribution box for the mount.
Though I use RCA jacks to connect devices I
try not to use pre-built RCA patch cords
which are generally made for audio
equipment using coaxial cable which, as I
mentioned earlier, is not designed for power
transmission. Male RCA plugs are cheap and
easy to solder to wire. Generally they come
with a bit of strain relief and are available in
several colours. Watch them though when
plugging and unplugging things when the

Fig. 34
power is 'live'. They can short things out.

The Nautilus ships with booster-cables (used once), compressor fittings (used often) and a nice little
'wall-wart' charger that will bring the thing back up to speed in a day which is good when the unit is
needed night after night.
In the field remember that things do dew up so if using any AC equipment it's a good plan to cover
power supplies etc. to keep them dry and happy.
If in a permanent observatory with mains power all that is needed to drive a lot of DC equipment is a
regulated power supply such as provided by Kendrick's
Astro Instruments. They offer 4.5 A or 10 A units (Figure
34) and have binding posts and/or a cigarette-type plug on
the front. Which one is best depends on the equipment
being powered. Calculate the current needed as you would
when selecting a battery.
When I am near power I use a Celestron 'regulated' power
supply (long on supply, short on regulation) which is
specified by them for my CGE mount. I also purchased a 5
A regulated (really this time) power supply from WalMart
which was designed to use with a 12 V cooler and
modified it with a triple cigarette-lighter plug. This one
was very inexpensive and very well designed. AC power
Fig. 35
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supplies are generally protected against over-current but this is not a rule. Read the warning on the next
page carefully.
Running AC equipment from a DC source requires an inverter of some form. These can range from
very small to very large; large enough to not be portable. The secret is to determine how much power
all of your AC gear draws and pick a unit that gives about 100% overhead.
Running a laptop in the field can be problematic as most draw a lot of power; and the power
requirements are getting larger as laptops become 'game rated'. Even a low-end laptop can draw enough
power to make using it difficult. The 200 W inverter (Figure 35) that I purchased to keep my Celeron
M laptop alive in the field does a great job, but it will kill a mini-van battery in about 5 hours. The
readout on the inverter told me that the laptop was drawing about 20 W at most times, a value I found a
bit hard to believe.
To power a laptop properly would require at least two good automotive batteries connected in parallel
(Figure 36). Deep-cycle RV batteries would be a better choice. These would allow enough power to
keep things alive through a long imaging session. Deep-cycle batteries can be drawn down and
recharged many more times than standard auto batteries.
Treat batteries well. Always top
them up after use and they will
be available when needed.
When I come back from a
session my battery goes on the
shelf with the charger plugged
in.
Newer batteries such as Gelcells and absorbed-glass-mat
batteries can't spill which
makes them a bit safer to use
but the cost will be more. Most
RV batteries are standard leadacid batteries. If the battery
used isn't maintenance free
check
the
electrolyte
periodically.

Fig. 36

Keep the battery terminals free of corrosion and clean them periodically; also inspect and replace any
frayed or cracked battery terminals. Keeping imaging batteries alive and kicking is much the same as
keeping a car's battery in the pink.
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Whether in the field or in an observatory equipment needs to be protected. A short in a heat
strip or any other piece of equipment can drive a power-supply into shutdown. If a set of
batteries are in use with no protection they WILL keep delivering power until something starts
to burn, or longer. Make sure that there are fuses on all of the battery's outputs. If using
cigarette type connectors use cables with in-line fuses and make sure that they can carry a
sufficient load. I suggest fuses rated at 200% of your average load and of a fast-blow design. I
have fuses internally in my booster pack and fuses in my cigarette connectors. It is always better
to be safe than sorry. And always carry spares of every fuse in use.

The Andromeda Galaxy imaged by the author using an 80 mm f/6 Nighthawk
II achromat from Stellarvue and an unmodified Canon XT. The images taken
to construct this were not guided.
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Sensors
Digital cameras have completely revolutionized astrophotography. Instead of film an electronic chip containing
millions of small pixel elements (pixels) captures and records
the photons that are impinging on them.
Without getting into a whole lot of quantum theory how a
CCD or CMOS sensor (they're pretty much the same, just the
circuitry is different) works is fairly simple. In Figure 37
there are a lineup of electrons (red balls) sitting waiting in a
trough. When a photon (blue ball) hits the pixel its energy
lifts a gate and lets an electron fall into a bucket. Almost
every photon that comes in releases an electron. I say almost
because nothing is certain when it comes to very small things
banging around. But today's sensors are 80-90% efficient.
Compared to the 1 to 5% efficiency of film, it's
understandable why digital has taken over astrophotography.
As the exposure continues the photons keep banging into the
pixel and electrons keep filling the bucket. At some point in
time the bucket is full and, on some CCD chips, the electrons
Fig. 37
can 'spill' over into the next bucket on either side. The way
that this happens is only in one axis; consider that the buckets each sit in the bottom of a trough.
Electrons can spill into the buckets along the trough but
not into the next trough.
When the exposure is done the shutter closes and no more
photons hit the pixel. Now is time to do a read of the chip
and create an image.
Reading the sensor is shown in Figure 38. This is done by
unloading each bucket and counting the electrons,
actually, measuring the charge.. So in our graphic a valve
opens and the electrons fall out of the bottom of the
bucket much like passing through a funnel into a tube
with a counter which increments one electron at a time.
The count is passed onto the camera's brain and all of the
numbers are arranged in rows and columns. Where there
are no or little electrons in a bucket that will be black, or
close to black. Where the buckets are full a high count or
white will show up in the image.
Fig. 38
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Of course, this is very simplified but fairly accurate. Instead of a counter the camera reads the charge in
each 'well', passes the charge through an analog-digital conversion to get a number and uses that
number to create the image.
Sensor chips come in all sizes these days with the largest generally found being the same size as a 35
mm film frame. Most DSLR cameras use a sensor in the APC-C size which is just over half the size of
a 35mm frame.
Here is a chart of the various sizes.

Type
1/6"
1/4"
1/3.6"
1/3.2"
1/3"
1/2.7"
1/2"
1/1.8"
2/3"
1"
4/3"
APS-C
35mm
645

Aspect Ratio
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3
4:3

Width
mm
2.3
3.2
4
4.54
4.8
5.27
6.4
7.18
8.8
12.8
18
25.1
36
56

Height
mm
1.73
2.4
3
3.42
3.6
3.96
4.8
5.32
6.6
9.6
13.5
16.7
24
41.5

Diagonal
mm
2.88
4
5
5.68
6
6.59
8
8.93
11
16
22.5
30.15
43.27
69.7

Area
mm2
3.98
7.68
12
15.5
17.28
20.87
30.72
38.17
58.08
122.88
243
419.17
864
2324

Relative Area
1
1.93
3.02
3.89
4.34
5.25
7.72
9.59
14.6
30.88
61.07
105.35
217.14
584.07

Each pixel in a sensor is very small, usually in the 5 to 10 micron range. There are those that think big
pixels are better and those that think opposite. The argument is that big pixels have a higher signal-tonoise ratio but in my mind, the jury is still out. The state of the art in CCD/CMOS chips is such that all
of the current crop are very good.
I mentioned above in my little description that when a
bucket became full the electrons could spill out of their
bucket and into the next. This is known as 'blooming' and
gives artifacts around bright stars such as shown Figure 39.
Most cameras these days contain anti-blooming circuitry
that minimizes this effect.

Fig. 39

Sensors are chosen by manufacturers depending upon the
job that they are expected to do. Smaller sensors generally
are used in guide cameras while the larger APC-C and full
frame sensors are used in imaging cameras. Each sensor
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also has a specification sheet that a manufacturer looks at with possibly the following items (See
Nomenclature).
Quantum efficiency (QE)
The percentage of photons hitting the photo reactive surface that will produce an electron-hole
pair (the electron in our bucket).
Full Well Capacity
This is the number of electrons that a pixel can hold before saturating and possibly causing
blooming.
Gain
When a CCD is read the pixel charge may be in micro-volts and an amplifier is needed to bring
the signal into the range where it is usable. The amount that the signal is increased is the gain.
An amplifier not only reads the signal, but reads any noise inherent in the chip which has to be
accounted for.
Monochrome or colour
A monochrome chip generally has, millimetre for millimetre, more resolution than a colour
sensor. This is due to it being able to register the light of all colours on each pixel whereas a
Bayer filter (see the DSLR camera section) splits the light impinging on a colour sensor
between red, blue and green pixels.
Sensitivity
Modern sensors are usable to very low light levels and therefore are considered highly sensitive.
Many can operate down to near zero lux (lumens/sq. metre).
Sensors can be used in arrays such as that used in the Sloan Digital
Sky Survey which is shown in Figure 40. Even though there is a gap
between each of the sensors the operators make use of a technique
called 'drift-scan' so that images come out seamless. This is a very
large array of sensors and along with the optical system that it uses
allows it a very large field of view.
Whichever sensor might be found in a camera one can rest assured that
the manufacturer has taken into account all of the uses that that camera
will be put to during the design phase. More important than the actual
sensor (other than physical size) is the circuitry that controls the sensor
and creates the image.

Fig. 40
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DSLR Cameras
When it comes to deep-sky imaging there are currently two camps. The first group are those that use a
DSLR camera like the ones that someone would take on vacation with the family. The other is the
'CCD' crowd that use purpose-built dedicated cameras. I'll discuss the DSLR first.
Any DSLR can be fit to a telescope using an adaptor and a T-ring
such as the Lumicon unit shown in Figure 41. This provides the
bayonet (or screw) mount such as that found on a standard lens on a
telescope The camera then just 'clicks' onto the telescope as it would
to a normal lens.
Many telescopes won't come to proper focus with only a prime-focus
adaptor and require some form of extension to be added to the optical
train. These are available in many different lengths from vendors
such as O'Neil Photo or Astronomics.
While any DSLR will work for astro-photography by far the most
Fig. 41
popular are the Canon Digital Rebel series. These are lightweight and
highly capable. One point of interest is that in the past Canon actually offered an 'astro-photography'
camera in the form of its model 20Da sadly, no longer available. Canon has offered the greatest support
to astro-imagers in the past and I assume that they will continue to do so.
DSLRs are, in the parlance of astro-photographers, single-shot colour cameras. This just means that
they take a colour image unlike the monochrome astro-cameras (more later). All of these use something
known as a Bayer matrix filter. These filters split the incoming light before it reaches the picture
elements (pixels) of the camera's sensor into blue, green and red. Normally, there will be two green
elements for each blue and red element as our eyes are mostly green sensitive. A representation of the
layout of the pixels is shown in Figure 42.
DSLR imagers generally take a lot of short
exposures instead of on long one. The software used
to process these first de-Bayer each image so that it
can work with the separate channels. Then it 'stacks'
them together (adds them) to create the final image
set which is then re-combined to provide a colour
product.
Most cameras will output their data in some form of
'raw' image which is the data straight from the
sensor or in a JPEG image of various sizes that has
Fig. 42
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been 'massaged' by the camera's processor. While some photographers do use their camera's JPEG
output, most work with the raw images.
Other than the hardware needed to mount the camera to the telescope, some method of remotely
triggering the camera is a necessity. In the old days this meant a cable or bulb release. These days a
remote is generally either infra-red (like a TV remote) or an electronic cable release. I've found that the
cable version is the best for me as I can use an intervalometer or computer to run the camera.
I'm not one of the CCD purists and I don't take 'scientific' pictures. I take pretty pictures and therefore
can trade less resolution for more ease-of-use. My choice is a Canon Rebel 500D DSLR modified by
Hutech to allow access to that deep-red hydrogen-alpha line and I generally run it from the same 12V
source that powers everything else in my kit.
The Rebels are nice in that they don't have a lot of weight to counterbalance, are physically small and
pack a pile of goodness into the small package. They've become the 'gold standard' for astro-imaging
over the past years and I agree with all of the other users that they're the most astro-friendly DSLRs
around.
CMOS vs CCD
There has been quite a discussion over the years as to whether a CMOS sensor or a CCD sensor is
better and the answer is, neither. These days either will work just fine and more thought should be
given to the camera size and form and the support from the manufacturer or the community for that
camera.
DSLR Power
Camera batteries don't last forever,
especially in cool weather so some kind
of power-supply is very nice to have.
Fortunately, camera power supplies are
fairly simple as they just take the 12V
from your power source and drop it
down into whatever voltage that the
Fig. 43
camera needs. For my Rebel, I use a
simple 7808 linear voltage regulator and
a heat-sink, and built them into a small project box. It has an RCA plug to bring 12V in and a 3.5 mm
mono phone plug to get the 8v needed out.
To get the power from your power supply into the camera some form of battery adaptor will be needed.
For my Canon XT I used one machined out of plastic but for my modified T1i I went another route. A
battery can be 'gutted' to build an adaptor which is what many do; but for my T1i I found an off-shore

40

company that supplied AC adaptors (the Canon offerings are horrendously expensive for what they do)
for about $35 dollars. I modified it and now I can power my T1i from either mains power or 12V.
For users of Canon cameras the manufacturer ships software with their cameras that can perform most
of ones exposure timing needs over the camera USB connection.
Most DSLRs these days have a fairly good LCD screen on the back
which can make focusing and framing much simpler than looking
through the viewfinder. The problem with either the screen or
viewfinder is that it helps to be a contortionist to look at them in
some orientations of the telescope. To ease aching necks and backs
there are two options available to most DSLR owners;to purchase a
90 degree magnifying viewer for the camera or to use a netbook or
laptop computer.
The Nikon DR-6 (Figure 44) is very good. It allows a 2x
magnification of the camera viewfinder which may be enough to
reach good focus.

Fig. 44

Better is to use a computer. This can be at the telescope with a
netbook or laptop or a desktop computer if working from the warmroom with a remote focuser. If the camera has a live-view mode this
is the best way to go as it can be used with a focusing mask (later)
or other aid at very high magnification.

Live-view modes on DSLR cameras use up a lot of battery so it is best to power the camera from an
AC-DC adaptor (wall-wart) or from some form of DC-DC converter (Appendix III)
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What are these modified DSLR cameras I hear about?
All of the DSLR cameras on the market ship from the manufacturer with an ultra-violet/infra-red cut
filter of some kind. These allow only light in the visual wavelengths to pass to the sensor which is fine
when taking pictures of a mountain or little Sally's birthday party.
Just below the visual band at a wavelength of 652nm is the hydrogen-alpha (or Balmer-alpha)
emission line. The photons of this band are emitted by an electron dropping from the 3 rd 'orbit' to the
2nd 'orbit' in a neutral hydrogen atom. Many nebulae are rich in hydrogen which means that they
radiate strongly in this light.
Modifying a DSLR consists or removing the stock UV/IR filter and replacing it with one that will
allow the 652nm wavelength light of hydrogen alpha to pass. The sensors themselves can 'see' the
light. Below is an image of a hydrogen-rich nebula taken with a modified DSLR and Hydrogen alpha
filter.

This is an image of the Heart and Soul nebulae (IC1805 and IC1848) taking in hydrogen alpha light
on my modified Canon DSLR.
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CCD Cameras
CCD imagers have gone a different route than the
DSLR crowd by using a dedicated astro-camera to
ply their vocation. These cameras are designed
specifically for use on a telescope and some of them
sport some type of research grade sensors.
While some single-shot colour cameras are available
most people use cameras that output monochrome
only which means that the imager takes four images
in order to get a colour picture. This is knowns as
LRGB imaging and stands for Luminosity, Red,
Green, Blue. The advantage of this method is that
higher-resolution images are available (sometimes)
along with more vibrant colour as the sensors tend to
be a lot more sensitive than those used in DLSR
cameras. Also, there is no Bayer filters or UV/IR cut filters getting in the way of the light.

Fig. 45

These cameras tend to be quite expensive and require the use of a computer in order to function. They
also tend to draw a lot of current which means that they are best used in a permanent setup in an
observatory. While some people do take them 'on the road' a lot of care has to be taken in designing a
'power plant' to keep everything running.
One of the big names in the CCD market is Santa Barbara Instruments Group (SBIG) which makes the
8300M camera shown in Figure 45. SBIG is nowhere near the only provider with cameras starting to
show up from many new manufacturers as the availability of adequate sensors increases and the prices
of the parts drops.
In order to take the separate colour images a
filter wheel and filters are required. These
devices fit between the telescope and the
camera and have a rotating filter holder that
can move a new filter into place in front of
the sensor as needed. Some are powered and
are controllable from a computer and some
have to be operated manually.
The newer cameras all use USB connections
to connect to the computers that control them
and store the images that they take.
Fig. 46
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These cameras almost all allow 'binning'. This means that a matrix of 2x2, 3x3 etc pixels can be treated
as a single pixel. A normal methodology is to shoot the luminance channel at full resolution and shoot
the three colour channels binned. The full resolution is not needed in the colour channels and the
camera can record the colour quicker binned.
Most of the cameras are also thermo-electrically cooled, many with the cooling controllable. Keeping
the sensor cool keeps a lot of thermal noise from building up and makes the job of the dark frames a lot
simpler.
CCD cameras come in many shapes and sizes, from those not much larger than a 2” eyepiece such as
some of the QHY models or the Loadstar guider right up to lunch box-sized units like the SBIG 11000
series. How much camera can be counterbalanced is sometimes the main parameter in choice. All of
the cameras on the market these days do a good job and some are close to the price of a modified
DSLR.

Bill Gardner shot IC405 in HaRGB with an Astro-Physics 155 refractor and
SBIG ST-10XME camera mounted on an Astro-Physics AP900GTO mount.
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Astro-photography With Camera Lenses
For large sweeps of sky or for imaging very extended objects
the telescope and astro-graph can be eschewed in favour of a
camera lens. Wide angle or telephoto, they all fit into the
spectrum of optics what can be used effectively to image the
night sky.
Camera lenses, in the most cases, have to be treated much the
same as their longer bretheren when it comes to deep-sky object
imaging. While shots of constellations can be taken from a
static camera tripod with shots of less than around 15 seconds,
any longer exposures should be taken from an equatorial
platform of some sort and long exposures or long telephoto
shots should be guided.

Fig. 47

Imaging with the family camera can be very satisfying. Large
scale objects such as bright comets, star clouds and extended nebulae are easily captured with short
focal length lenses while the grist for longer telephoto lenses runs from the moon to the nearer galaxies
and bright nebulae.
With a camera on a tripod the stars will start to trail immediately after the shutter is opened. Just how
long an exposure can last without severe trailing depends on the focal length of the lens and the size of
pixels on the sensor. First determine the field of view and arcseconds per pixel:
FOV =
arcsed/pixel =

2atan(0.5w/f)
FOV/number of pixels across * 3600

For a Canon 500D and a 50 mm lens the field of view would be: atan(( 22.3/50) *.5) * 2 or 25.142
degrees. Next determine the arcsec/pixel. The 500D's sensor is 4770 usable pixels across. Dividing the
25.142 degrees by 4770 then multiplying by 3600 (arcseconds in a degree) returns 18.9 arsec/pixel. The
stars move past at 15 arcseconds per second so this combination will show no trailing in a 1 second
exposure and in a 15 second exposure the stars will trail 12 pixels. As the FOV scales linearly this can
be extrapolated to a 100 mm lens which would have stars trailing 24 pixels and a 200mm lens where
they would trail 48 pixels. To determine what is and what isn't acceptable only shooting will tell.
Camera lenses, especially those designed for consumer use are generally not the greatest optical
components built and most display a lot of softness when the aperture is wide open. A consumer 'kit
lens' such as the 18-55 mm zoom that Canon ships with their cameras has a focal ratio range of f/3.5 to
f/5.6. These lenses should be shot in manual mode with the aperture set to f/5.6 at 18 mm or f/8 at
55mm. Stopping down the lenses masks off the worst part of the lens making the image much sharper.
Of course, exposures will lengthen.
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Camera mountings
Pleasing images can be shot from a standard
photographic tripod as long as exposures are kept
below the point that trailing gets out of hand.
Exposures can't be long enough to register much
in the way of nebular or star colour or much in the
way of the star clouds of the Milky Way.
The next step up from a tripod is to use a barndoor tracker. These are small devices, generally
made out of wood, that will track the earth's
rotation for short periods. Some are turned by
hand and some have had motors attached. The
example in Figure 48, built by Chris L. Peterson
of Colorado, is fairly representative. Note that his
is motor driven. The camera is held by a small
ball-head that is attached to the tracker allowing it
to point to any section of the sky. Instructions on
how to build these are easily found on the web.

Fig. 48

These work by having the hinge(s) pointed at the celestial pole. Then by turning a threaded rod the
'barn door' opens which properly allows the camera to track the night sky as the earth turns. A simple
unit comprised of two boards with a hinge will allow shorter exposures but the more complex units
with two or three boards reduce the tracking errors to very low levels.

Fig. 49
Better than a barn-door tracker is a purpose-built tracking device such as the Kenko SkyMemo or the
Astrotrac (figure 49). These attach to a camera tripod and, when properly polar aligned can track to a
high degree of accuracy. Either the SkyMemo or the Astrotrac are able to very accurately keep a
camera tracking for quite long exposures, but there is no method available to do any guiding of the
images.
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The last method and the best of course for wide angle imaging is to mount the camera and its lens on a
telescope mount and shoot the images just as if imaging with the main telescope. This necessitates
having some method of attaching a camera to the telescope or mount.
Celestron and Meade each offer a 'piggy-back' adaptor that screws to their telescope tubes and allows
the attachment of a camera using the standard 1/4-20 screw on the bottom. Third party vendors such as
Losmandy and ADM offer a full line of piggy-back adaptors that can be used on just about any mount.
These allow you to shoot wide angle using your normal astro-photography equipment. Piggy-back
adaptors can be simple brackets such as the Meade unit in Figure 50 or can be 2-axis or even 3-axis
adaptors that allow the telescope and camera to point in completely different directions.
Once the camera is powered and pointed there has to be
some method of tripping the shutter. Many DSLRs have
the provision to have a remote shutter release attached.
These can either be simple push-and-lock remotes or
have some intelligence and act as an intervalometer, a
device that allows a sequence of exposures to be
programmed and automatically shot.
A good intervalometer, such as the TOGA
Intervalometer, allow the use of mirror lock-up; a
function of the camera that flips the mirror up and then
waits a set amount of time before opening the shutter.
This allows any vibration from the heavy mirror raising
to settle down before the shutter is opened. If there is no
mirror lock-up (MLU) on a camera then the 'hat trick'
can be used. A hat is held over the end of the lens and
the shutter is tripped. After a few seconds, when the
vibration has settled, the hat is removed and the
exposure starts.

Fig. 50

Wide Angle Imaging
Arbitrarily I've split the spectrum of focal lengths of camera lenses into three groups. The first is the
wide angle group, those lenses of less than 100 mm focal length. In the middle of this group is the old
standard lens, the 50 mm, a most versatile lens.
The normal wide angle lens that is offered by most camera manufacturers is the 28mm, which is also
the bottom end of many zoom lenses that are offered. A good 28mm lens is a wonderful wide field lens
that offers the ability to image sweeping vistas of the heavens, especially useful along the Milky Way.
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Medium Telephoto Imaging
Lenses with focal lengths from 100 to 200 mm fall into my category of medium field. One of the most
useful of lenses, the Nikkor 180 mm ED f/2.8 falls into this range and should be in every imager's kit if
it will fit their camera. Nikkor lenses will fit onto Canon Rebel bodies with an inexpensive adaptor.
The 180ED incorporates an element of extra-low dispersion glass that allows it to deliver pinpoint star
images with the aperture set wide open at f/2.8. This lens works out to a very fast 70mm refractor with
5 elements to keep aberrations in check. A manual focus version can be found on the used market for a
few hundred dollars.
A medium or long telephoto lens can put a lot of stress on the attachment ring on the camera. When
being hand-held this is no problem as the lens is supported. On a piggy-back adaptor the camera itself
is being held and the heavy lens is suspended
out front. Some manufacturers offer collars
that go around the lens and attach to a tripod
(or piggy-back adaptor). Guide-scope rings
can be used if care is taken while tightening
them to not change focus as the rings may
have to clamp on the focus collar.
Long Telephoto images
Above 200 mm the lenses fall into the long
telephoto category. Good specimens of these
lenses are very expensive, more expensive
than most telescopes in the short
apochromatic telescope category. They do
Fig. 51
though offer a wider field than most
telescopes and perform as well. These long lenses require guiding or at least well polar-aligned
tracking.
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Dan Williams shot this wide-angle of the Andromeda Galaxy from a tripod
using a Canon DSLR and 70-200 f/2.8 zoom set to 195 mm. Four seconds at
ISO2500
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Auto-Guiders
While some people may enjoy staring at a reticule
for hours, most imagers these days make use of
some form of auto-guiding when plying their
avocation. Since the first commercial auto-guider
hit the market in the form of the SBIG ST-4,
staring at a reticule became a thing of the past.
With the advent of small and efficient portable
computers and small, sensitive cameras, autoguiding is available now to just about anyone.
With so many people starting to take images
through their telescope the stand-alone guider (no
computer) has even made a resurgence.
Fig. 52
Auto-guiders these days fall into three distinct
categories. Those that don't need a computer,
those that do need a computer and those than only need a computer to configure them. Those may
sound like odd categories but they describe well the way things are.
For many years the only stand-alone auto-guider was the SBIG ST-4. These were discontinued in about
2002 due to lack of components but very many are still being used by imagers. They run from a 12 V
source and don't need any external computer to operate. This was the situation until a few years ago
when the Orion Solitaire started shipping (out of stock as of this writing) at around $500. In 2010
Celestron and SkyWatcher jumped into the market with the NexGuide/SynGuide products, stand-alone
guiders that also run off of 12 V for about $300 (Figure 52).
In the category of those auto-guiders that need a computer only some of the time is the SBIG SG-4, a
descendant of SBIG's original guider. These need a computer to be configured, but once that is done
they can run on their own.
The last category are the guiders which need a computer. These are generally software based and use
anything from a simple webcam to a dedicated guide camera to operate. The camera only captures the
images which software on the computer then processes. A list of popular software guiding packages are
shown below. All are free for download.

Guide Dog

www.barkosoftware.com/GuideDog/

GuideMaster

www.guidemaster.de/index_en.asp

MetaGuide

www.astrogeeks.com/Bliss/MetaGuide

PHD Guiding

www.stark-labs.com/phdguiding.html
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In order to interface the computer to the mount's auto-guide
port something like the TOGA LX-Guider/Focuser or the
Shoestring Astronomy GPUSB unit will be needed. Both of
these work with the standard ST-4 auto-guide port that is
offered on most mounts. Both can also make use of a feature
called 'pulse-guiding' that provides a more accurate timing
source than the software timers.
The next part of the guider system is the guide-scope, or
alternatively an Off-axis-guider (OAG). A guide-scope is
usually a small aperture refractor that rides on the mount
Fig. 53
above or beside the main imaging scope and to which the
guide-camera is attached. This is usually adjustable in two
axes by riding in a pair of over-sized rings with screws spaced every 120 degrees. This is a tried-andtrue system but was, I'm afraid, invented by a sadistic astronomer. This method is nowhere near the
easiest way to find and centre a guide-star and Orion has offered an X-Y Guide-star Finder which
allows the use of only two adjustment screws (up/down and left/right) to centre the chosen guide-star.
My guide-scope is mounted the old fashioned way with two rings and spaced thumbscrews. I purchased
the system from Ken's Rings of Louisiana.
An alternative, and relative newcomer to the guide-scope market is the finder-based guider one of
which is offered by KW Telescope as the KwikGuider. This mates a high-quality guide camera from
QHY to a simple achromatic finder. There are no adjustments needed as the field of view is so great,
and the sensor so large that there is always a star somewhere in the field that the software (usually PHD

Fig. 54
Guider) can find. This lightweight and sturdy unit fits into the standard finder dovetail found on most
mounts.
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The problem with all separate imaging/guiding scope setups is 'differential flexure' (see the section on
this subject). This problem manifests itself when the imaging and guide-scopes don't remain in perfect
orientation. There are two solutions to this. The first is to use
an off-axis guider (Figure 54, right). This rides between the
imaging telescope and the camera and has a pick-off prism
that projects into the light path and redirects a star image up to
the guide-camera. The second is to use a dual-chip camera
(Figure 54, left) such as those that SBIG offers. These have a
large imaging sensor and a small guiding sensor in the same
focal plane. Both the OAG and dual-chip setups eradicate
differential flexure but limit the choice of guide-stars.
If a separate guide-scope is being used along with a standalone guider then there is no more useful accessory than a
flip-mirror. These mount between the telescope and the guidecamera and have a mirror that can be flipped out of the way to
image, or into the light path to direct the output of the
telescope up to a reticule eyepiece (eyepiece with cross-hairs).
When a star is in the cross hairs it is on the sensor of the
guide-camera, and in focus.

Fig. 55

Reticule eyepieces are regular type eyepieces with an internal reticule that may be illuminated or not.
Many different types can be purchased with some more complex than others. For guide-star acquisition
the best type would be either a simple cross-hair or perhaps the more common dual cross-hair.
A guide-scope has to have some way of being mounted to the imaging scope, or mount. Some people
like to have their two optical tubes 'stacked' and others like them side-by-side. I'll use either depending
on the mount I'm using but I prefer the side-by-side method. Side-by-side plates for any mount dovetail
can be had from ADM or Losmandy.
Guide-scopes don't have to be all that
fancy. Just about anything with a lens that
will form an image can be put to use.
Good finder scopes can be modified
nicely to guide an image using a simple
web-cam or 'solar system imager'. Figure
56 shows a 'baby-guider' that I put
together using a good quality Antares
7x50 finder and a Celestron NexImage
camera.
I'm not a fan of the off-axis-guider and
therefore always use a separate guidescope to keep things pointed correctly. I

Fig. 56
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opted for a Stellarvue Nighthawk II (now discontinued) 80 mm f/6 achromat. It's just about the best
guide-scope around being light, solid and having great optics.
I either guide using a venerable ST-4 auto guider (above), or I use a Celestron NexImage camera and a
TOGA LX Guider/Focuser and a laptop or netbook. Both will keep things pointed well enough to
deliver round stars from images up to 10 minutes long with the CGE.
With the Nighthawk and ST-4 I use a Meade 644 flipmirror (Figure 57) with a custom-made tail piece that
my best friend, David Rubenhagen, machined up for
me. This was necessary as I bought the thing used and it
didn't come with any of the spacers that ship with them
from the factory. The machined part is stiffer than the
spacers..
With all of the new self-contained guiders coming on
the market these days why keep using an old ST-4? The
answer is simple in that it works well and I already own
one. Would I recommend a used ST-4 over any of the
Orions, Celestrons or SBIGs currently shipping? You
bet. The technology is bullet-proof and the outcome is
phenomenal. If my ST-4 ever dies I'll look for another
used one on Astromart or somewhere else.

Fig. 57

As I mentioned, I don't use the ST-4 all the time. If I'm in a place where I can use a computer I have no
problem swapping the ST-4 out for the Celestron NexImage /TOGA LX Guider/Focuser pair. The
CCD-based NexImage is sensitive enough to guide on a 9th magnitude star with the 80 mm f/6 scope
and can be used with either TOGA's software or the stellar MetaGuide video-based guiding software
from Astrogeeks.com.
As mentioned previously my guide-scope normally rides on a side-by-side plate with either the
SV102ED or the AT8IN scope but it can ride piggy-back on either. I've found that the side-saddle
approach is best for me as I don't have much in the way of flexure problems and it is easier to reach the
reticule eyepiece in most orientations. My side-by-side (SBS) unit is home-made, heavy and doesn't
flex AT ALL. It also allows me a lot of versatility in mountings. The imaging telescopes use Vixen style
dovetails while the guide-scope uses a Ken's Rings style. The SBS uses both of these while mating to
the Losmandy carrier on the CGE. It sounds complicated but there are reasons for putting it together
this way.
Another benefit to the side-by-side unit is that it allows me to over-balance my whole setup in
declination very simply. Similar to balancing the mount in RA east-heavy, having the dec axis off
balance is a good way to fight backlash.
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So, how do auto-guiders work? Well, no matter what type of setup they all work basically the same
way and the work-flow looks something like this:
•
•
•
•

Acquire guide star
Focus
Calibrate
Track

Acquiring the guide star can be as simple clicking on one on a computer display, or looking at the
readout or some other indicator on a stand-alone auto-guider. Some guiders will automatically select a
guide-star from any stars in the field while others allow one to pick and choose.
Once a suitable star is found the guide-scope should be focused. Oddly, the old ST-4 seems to prefer a
slightly de-focused star in some cases; but generally a well-focused star image is to be preferred.
Calibration consists of the guider moving the mount N/S and E/W in a cross or L pattern to determine
how much the chosen guide-star moves in a specified amount of time. Some guiders can be configured
to take into account any backlash but it's always a good idea to use the anti-backlash settings on your
mount to minimize this. Once the calibration is done the system stores an image to use as its reference,
then takes more images spaced as desired and compares them with the stored reference. If the star has
moved on the sensor the auto-guider will nudge the scope to bring it back into position. Good guiders
can guide to around ¼ to 1/5 of a pixel.
Always try to pick a guide-star that is in the field of the imaging camera. The farther away from the
target a guide-star is the more field rotation can show up. This manifests just like a non-aligned mount
and rotates the field around the guide-star.
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Pete Raine shot this image of M1 using an AstroTech 8” Ritchey-Chretien on a
Celestron CGE mount. Shot with a Canon XT and Lumicon Deep Sky Filter.
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Focusers
Three basic types of focusers are common on astro-graphs: the helical, the Crayford and the rack-andpinion. All perform the same basic function of moving a camera along the optical axis to bring the
sensor to the focal plane.
Rack-and-pinion focusers use an in-line gearing system to move the focuser's draw tube in and out.
Cheaper units are generally poorly built and display a lot of backlash among other problems. These
should be avoided. Good R&P focusers, such as those offered on Takahashi telescopes are a dream to
use and are better than many low-end Crayford types. They are also generally better at holding a large
camera than the Crayford designs.
Instead of a gearing system Crayford focusers use the friction of a
rotating steel bar running against a 'flat' machined into the draw tube
(Figure 59) to move the draw tube in and out. The draw tube is kept in
position by (usually) four small ball bearings opposite the focusing bar.
Crayfords are adjusted by either putting tension on the focusing bar or
by putting tension on the draw tube. The latter is not a good system as it
can 'cock' the draw tube pushing the camera out of square with the
optical path.
Crayford focusers have become the de-facto standard as almost all
optical tube companies put them on their offerings. Units made by
Moonlight, Starlight Instruments, JMI and others are all very well built
Fig. 58
and are offered as either standard equipment or premium options on
many telescopes. The king of focusers in my opinion is the Feather Touch line which use a twist on the
standard Crayford focuser called the 'reverse Crayford'. These are a joy to use being silky smooth in
operation and able to hold a good load without slipping.
Helical focusers are wonderful units that will hold a lot of
weight and adjust for focus beautifully. They have two main
problems:. first that the instrument rotates while focusing and
second that they are very difficult to motorize.
Most focusers come with some form of brass compression ring
in them where the camera adaptor is inserted. These might be
fine for eyepieces and were first offered so that the thumbscrews
don't mar an eyepiece's barrel. For imaging they are not very
good as they tend not to hold the camera very tightly and it can
'cock over' putting it out of alignment (see the section on
Fighting Flexure). A much more useful system would be for the
focuser to have two tightening thumbscrews 120 degrees apart
Fig. 59
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and no compression ring. FeatherTouch focusers have both two screws and a compression ring and I've
had no problem with mine.
Another thing that can throw your camera out of square is the focus locking method used by the
manufacturer. Most makers lock their focusers by tightening a thumbscrew thereby adding pressure to
the draw tube. This can tilt the tube out of square. Look for a focuser that can be tensioned enough to
hold your camera without having to be locked or, better yet, a focuser where the brake (lock) acts on
the rotating bar and not against the draw tube.
Whichever type of focuser is chosen the only really important thing to look for is that it holds the load
to be used securely and square to the optical path. Anything else is just luxury.
Continuing on the subject of focusing and focusers I am of the mind that no imaging telescope should
be without a powered focuser, especially if a laptop or other computer is available at the telescope.
Powered focusers are offered by companies like JMI and
can be units with simple DC motors that just turn the
focuser in and out or more complex devices with stepper
motors, temperature compensating circuitry and other
fancy stuff. Some units can also do auto-focusing with
suitable computer software.

Fig. 60

Power can be added to just about any focuser. JMI offers
'MOTOFocus' units such as the one shown in Figure 60
for just about any make and model of focuser on the
market, and for a very good price. These units are well
thought out and very useful. An added bonus is that they
are simple to convert to computer control. I have one on
the FeatherTouch focuser my Stellarvue refractor is
equipped with and I love it.

For those that are on a budget devices like the TOGA LX-Guider/Focuser can be very useful. These are
able to control two DC powered focusers from a computer. Using the live view built into a DSLR and
the TOGA webcam window showing the output of a guide-scope, an imager can make sure that both
scopes are properly focused all the time.
All of my optical tubes carry Crayford focusers. Two of them are the standard inexpensive units that
shipped with the scopes and one (my Stellarvue SV102ED) carries an optional FeatherTouch unit.
All of them do the job they have to do quite nicely. The AstroTech (GSO) focuser on my 8” f/4 is not
perfect, but it holds my DSLR nicely without focus lock and that's all I ask of it. Both the AstroTech
focuser and the FeatherTouch are powered; the refractor with a JMI MOTOFocus unit and the reflector
with a home-brew motor (see the DIY section).

57

The JMI MOTOFocus utilizes a very tiny gear head DC motor that screws to a ring that fits onto the
FeatherTouch focuser just inside the coarse focus knob. The motor drives the fine focus knob via a
rubber O-ring on a pulley that makes contact with the knob. Not the best system but it works. With the
MOTOFocus in place manual focusing is only available using fine focus.
The JMI controller is interesting. It has three basic speeds but when set to either of the slower speeds
holding down a button for over 2 seconds kicks the focuser into high. This can be disconcerting at
times but it appears to work. A 9 V battery drives the whole thing.
Two focusing methods
Using computers and good focus aids acquiring that perfect focus is no longer a black art. I image with
a DSLR so one of the two methods that I'll discuss will be DSLR-ish while the other can be used by
anyone that has a computer handy.
Using the camera's LiveView and a netbook computer has made life very simple. I slew to a bright star
near my target and place a Bahtinov mask (see section on focusing masks) on the telescope. With the
Canon and TOGA software running I can adjust focus to perfection using the netbook to display the
output from the camera.
A modification of the
first method is for
those cameras with
no live video. Setup
just as in the
previous paragraph.
Next shoot a 10
second exposure and
with the image on
the camera's LCD (or
computer
screen)
zoom in and look at
the state of the focus
which can then be
adjusted if necessary.
Repeat as needed. It
takes a bit of time
but focus will be
achieved.
The author shot the Pleiades with an unmodified Canon 350D and Stellarvue
SV102ED mounted on a Celestron CGE.
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Focusing Masks
Focusing masks are opaque sheets that are placed over the front of a
telescope to block most of the light from entering. The light that is
allowed to enter does so only through strategically placed holes in the
mask to either create multiple images or a diffraction pattern. These
are used as focusing tools and are designed so that the pattern created
at focus is different from that created out of focus.
The simplest focusing mask and possibly the oldest is the Hartmann
mask. This may have two or several holes in it allowing light to enter.
Technically a mask with two holes is a Scheiner disc but in common
usage all of these are known as Hartmann masks. Some have round
holes and others have triangular holes that add diffraction spikes to
the images created but they all work the same way. Shown in Figure
61 are the two types of masks.
The way that a Hartmann mask works is that the light impinging on
the optics will, if out of focus, create as many images as there are
holes in the mask. With the mask above left two images will be
created whether the optics
are inside focus or outside
focus. The mask below left
will create three images
Fig. 61
along with six diffraction
spikes. Adjusting the focus will cause the images to either
converge or diverge. When they converge to a single image
then the optical system is in focus as seen in Figure 62. When
the focus is long or short (top and bottom grphics) two star
images are seen. When in focus these merge into the single star
shown in the centre graphic.
The drawback with a Hartmann mask is that there is no
inherent way of knowing whether one is inside or outside of
focus, and therefore no indication which way the focuser has
to be racked to get the images to converge. This may not sound
like a great drawback, but some folks, especially those
operating their telescopes remotely feel that having that
indication is a good idea.
There is a Hartmann mask template generator on-line at
Fig. 62

http://www.billyard-ink.com/Hartmann.shtml
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Another focusing mask that is a bit more complicated than a
Hartmann mask is the Bahtinov mask. This was designed by a
Russian amateur astronomer named Pavel Bahtinov. It consists of
three grids of straight lines in the mask; two angled outward and
one below those that bisect them.
A Bahtinov mask is placed over the front of a telescope that is
pointed at a brightish star. The image of the star will be a
diffraction pattern shaped like an X with a long spike running
through the X.
When in focus, the long spike
perfectly bisects the X. At other
positions the long spike will be on one
side of the X or the other as shown in Figure 64.

Fig. 63

Achieving critical focus is very simple if the image can be inspected at a
high enough magnification. I have found that LiveView on my modified
DSLR does magnify the image enough so that rough focus can be achieved
but I have to take short exposures and inspect them changing focus between
shots in order to get perfect focus.

Fig. 64

When taking images with the Bahtinov mask in place it is very easy to see
whether the optics are in focus or not. With a DSLR I can zoom in a lot
farther on an image being displayed on the LCD after shooting than I can
using the LiveView therefore making my judgement of focus much better
The image in Figure 65 of Sirius through a Bahtinov mask and then with the
mask removed shows the diffraction pattern..

Fig. 65
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There is a new software tool on the market for
use with a Bahtinov mask called Bahtinov
Grabber. This freeware allows a section of a
computer screen displaying a Bahtinov
diffraction pattern to be analyzed. When perfect
focus is achieved the software sounds a tone and
shows a notification on screen.
This software requires that ASCOM 5.5 be
installed and, with that software, can use ASCOM
compliant focusers to auto-focus a telescope to a
very high degree of accuracy. The software
window is shown in Figure 66 with the selected
screen portion displaying a Bahtinov diffraction
pattern and other controls above.

Fig. 66

The auto-focus routines are in alpha as of this writing but with ASCOM providing the interface it
shouldn't be too long before accurate and inexpensive auto-focus is available to all.
Figure 67 shows a Windows framegrabber displaying the Bahtinov
diffraction pattern with the Bahtinov
Grabber capture window showing
it's 'in focus' display.

Fig. 67
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The last focusing mask that I will discuss is a newer mask
than the Bahtinov that works along the same lines in that the
diffraction pattern is analyzed to test focus. This is the Carey
mask and was invented by a British amateur.
This mask was invented to make exact determination of focus
easier and yet still provide an indication of which way to
move the focuser in order to achieve focus. To do this the
mask must be placed on the telescope in the same orientation
each time it is used.
The Carey mask has two sets of slots cut in with one set at 12
degrees and the other at 10 degrees. They create an X-shaped
diffraction pattern with two X's overlaying each other. When
Fig. 68
inside of focus one side of the X will be splayed apart and
when outside of focus the other side will be. When the two
are evenly overlapped then the optical system is in focus as can be seen in Figure 69 where the right
hand panel is in focus and the other two are approaching.

Fig. 70

Fig. 69
When in perfect focus the two X's can be seen to be evenly splayed as Figure 70 shows.
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Automatic and Remote Focusing
Automatic Focusing
There are software/hardware systems that can
automatically focus an image under computer
control. These work by taking an image, or
looking at a video stream, and measuring the
full-width-at-half-maximum (FWHM) size of
a star image (Figure 71).
These systems are not expensive and comprise
of a highly controllable motor, usually a
stepper motor, along with control and
communications circuitry. They generally talk
to a computer through an RS-232 connection.

Fig. 71

In order to focus automatically, the software needs to have control of the imaging camera. It will then
take short images and analyze a star. Short images
work best as the star image selected should not be
saturated. The software can then generate a brightness
curve such as the one shown above and measure the
diameter of the star at ½ of the maximum value. The
optical system is then refocused if needed and further
images taken until the FWHM reaches the smallest
value; at which point the image is in focus.
Technical Innovations Robo-Focus hardware (Figure
72) is a full implementation which can be software
controlled for automatic focusing. These units are
Fig. 72
available for
many
different focusers and Technical Innovations also provides
software to drive the system. ASCOM drivers (a client/server
architecture for running astronomical gear) are available so
that other vendor's software should be able to access the
hardware.
A new offering on the market is the Armadillo from Lunático
Astronomia in Spain. It connects to a computer and can
control two stepper motors at once. It is compatible with the
Fig. 73
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Robo-Focus mentioned above and the stepper-powered focusers from Starlight Instruments or
Moonlight Telescope Accessories. It too is ASCOM compliant.
Remote Focusing
Focusing a telescope remotely is something that is of
great advantage whether it is done automatically or
manually at the keyboard. Several companies offer
computer controlled focusers or hardware to mate to
powered focusers.
From Jim's Mobile is the JMI PC Focus Control that plugs
into a USB port and allows control of a DC motor
powered focuser such as the MOTOFocus, also from JMI.
The PC Focus Control comes with software to run the unit
Fig. 74
and needs no special drivers. It takes all of it's power,
including that for the motor, from the USB connection and therefore is limited in the size of motor that
it can power.
Another offering that allows remote focusing is the TOGA LX Guider/Focuser from Two Old Guys
Astrogear. This unit connects to a PC using a USB cable and will drive two DC motors of any type
from the software provided. Drivers for the USB connection are provided and the unit is ASCOM
compatible to a degree. The standard LX200 ASCOM driver will allow use of one motor.
The TOGA unit also has an ST-4 compatible auto-guider port, DSLR
shutter control and adjustable fan power. With its proprietary software
two focus motors may be powered and controlled with adjustable
speed or 'pulse focus' for fine control.
For information on a DIY implementation of a powered focuser see
the DIY section.

Fig. 75
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Field Flatteners, Focal Reducers and Coma Correctors
One accessory that has become almost de rigueur in imaging
these days is the field flattener. Almost all telescope designs
have some curvature of field which means that the focal plane
is not a flat surface but is a section of a curve. Some types
show more curvature than others but very few designs are truly
flat without a bit of help. The ones that are touted to be flat still
aren't flat, but are flat enough over the field they will be
working at.
Curvature of field manifests itself in stretched stars in images.
The stretching effect starts immediately on departing the
optical axis towards the edge and is most profound in the
Fig. 76
furthest corners of an image. The stretch is radial so the stars
look like oblongs pointed towards the centre of the image.
Figure 76 shows the effect of curvature.
In the graphic below the left image is a refractor objective with three sets of rays coming to focus to
show the curvature of field. This is both highly stylized and grossly exaggerated; so if you're a budding
optician ignore the drawing and concentrate on the theory. In the right graphic a two-element field
flattener has been added.

Fig. 77
Focal reducers are lenses that are placed in the light path to shorten the focal length and thereby
increase the field of view. This is shown in Figure 78 with the normal focal plane shown in mauve and
the new focal plane in black.
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Fig. 78
Focal reducers and field flatteners can be purchased separately but often they are bundled into one unit
as shortening the focal length tends to increase the effect of curvature.
Figure 79 shows the Williams Optic Flattener III
reducer flattener. This unit has a camera's T
adaptor incorporated into it and reduces the
focal length to 80% of original; so an f/6
refractor would become an f/4.8 refractor with
the field flattened. It will work for many
telescopes.
Fig. 79
In Figure 80 is a field flattener/focal reducer of a
design offered by several manufacturers. This one is a
Meade f/6.3 reducer that is designed to flatten the field
of their non-ACF Schmidt-Cassegrains and change the
focal ratio from f/10 to f/6.3. These are usable either
visually or photographically.

Fig. 80
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Some forms of reflecting telescope, notably those of Newtonian
design, display a form of off-axis aberration known as coma. This
makes stars turn from points of light into little 'seagulls' or
wedges. The farther a star is from the optical axis the greater this
effect. Faster optical systems display greater amounts of coma
than slower ones (f/5 vs f/8 for example).
To correct for coma makers of Newtonian astrographs generally
build in a set of lenses to both return the stars to pin-points and
also flatten any curvature-of-field. For telescopes that don't have
coma correction built-in Baader Planetarium offers the MPCC
(Figure 81) and TeleVue has the Universal ParaCorr (Figure 82).
Both of these drop into a 2” focuser and work with telescopes
within a fixed range of focal ratios. In the case of the MPCC the
range is from f/4 to f/6 and for the ParaCorr f/3.5 to f/8.

Fig. 81

The MPCC doesn't change a telescope's focal length while the ParaCorr does show a small
magnification effect so if focal length and field of view are of prime importance this should be taken
into consideration.
Proper collimation of a telescope equipped with a coma
corrector is extremely critical and should therefore be
checked and adjusted if needed before every imaging
session.
The TeleVue offering accepts all of that company's 2.4”
imaging system accessories while the MPCC is threaded for
any standard photographic T-ring. Proper flange-to-sensor
spacing is maintained by both.

Fig. 82
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Dew Control
Any telescope in a humid climate that has an objective lens or a
corrector plate at the front of the tube will eventually need some
active method of fighting dew. Optics cool rapidly at night and
eventually they will drop below the ambient temperature to a point
where any moisture in the air condenses out onto the lens (dew
point). Once your optics dew over your imaging session is finished.
The dew-free time that is spent in the field can be lengthened by
placing a simple dew shield over the front of the telescope. This
passive device limits the amount of sky open to the lens and
therefore slows the cooling of the lens enough to keep things going
for a while longer, but not indefinitely. Eventually though some
active method of fighting off the dew must be considered.
There are many anti-dew systems on the market these days which
range from very simple units to very complex and expensive devices
that can be remotely controlled. No matter the price or complexity
they all work the same way, by providing just enough heat to keep Fig. 83
the optics slightly above ambient temperature and thereby never
letting the optics drop in temperature to the dew point.
When an electrical current is run through a resistive load that load will heat up. Connecting a resistor
directly to 12 V would have the resistor becoming too hot so what all anti-dew systems do is to turn
the current on and off rapidly varying how long the current is on against how long it is off. This is
known as Pulse Width Modulation.
The two waveform graphics show how a heat strip is turned on either 30% of 70% of the time. The

Fig. 84

Fig. 85

strip powered on 30% will radiate less heat into the optics.
Dew control has been Kendrick Astro Instruments' bread and butter for years and they offer many
controllers, one of which is sure to meet your needs. Their Premier Controller is shown in Figure 83 as
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an example. They also offer resistive anti-dew strips which attach to the front of the telescope tube via
Velcro and models that attach to just about anything else that needs heating.
How much heat is needed is a question that
is asked often and the answer is 'generally
not a lot'. Most of the time I spend in the
field my heat control is set to either 30% or
40% and is only turned higher on the rare
occasions that I've missed the start of dew
and need to clean a misty lens.
Thousand Oaks Optical makes a very
inexpensive heater controller that has four
separately settable channels (Figure 86).
These are compact and effective.

Fig. 86

When connecting any PWM heat controller to the power supply remember that the current being drawn
doesn't change just because the loads are being turned on/off rapidly. If a heater load draws 3 amperes
at full power it is still drawing 3 amperes for those times that it is turned on in the cycle. Select cabling
and fuses accordingly.
Positioning a heat strip is a personal preference. On my refractors I position them just behind the
objective cell on the main tube. Other people wrap them around the dew shield of the telescope. I don't
think that either way is better than the other but putting them on the tube means I can buy a slightly less
expensive strip.

Fig. 87
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USB Hubs
If a computer is to be used to talk
to all the many bits and pieces a
USB hub near the mount
somewhere will be a necessity.
Most guide cameras, focusers and
other gear have USB connections
but if they don't converters are
available. Using USB means that
only a single line to the computer
can be operating many devices.
USB can only source 500mA of
power per port on a computer and
with all of the things plugged into
a hub it is easy to go over that
current level. In the field an
adaptor to turn 12 V into whatever
Fig. 88
the hub uses will be needed. For
fixed installations most hubs ship with an AC/DC adaptor (wall-wart). Either way, you get to go over
the 500mA limit..
Another consideration is the cabling that will be needed to get from the computer to the hub. The USB
2 specification limits the cable length to 5m. Any longer run may degrade the speed and/or stability of
the connection. To get around this limitation use a powered extension cable. These are available from
many sources on-line for about $30 and allow a second 5m cable to be used to increase the run to a
total of 10m from the computer to the hub. With some it is possible to span even further by adding
more powered extensions, but for long runs perhaps a USB/Ethernet hub would be preferable as long as
full USB2 speed isn't required.
How many USB ports are needed is a function of how many
things you want your computer to 'talk' to. Normally a three-port
hub would be fine, but if something like the TOGA LX
Guider/Focuser or GPUSB from Shoestring Astronomy will be
in use to control things, four or more might be needed. These
will be for:





Computer control through a planetarium program
Image download from and control of a DSLR
TOGA LX Guider/Focuser
Guide camera
Fig. 89
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To control a mount it will probably be necessary to purchase a USB to serial dongle as most mounts
these days don't come with a USB connection. I have two of these of different makes, both of which
work perfectly with my Celestron CGE and my HEQ5
For those situations where a longer run than 5 or 10m is involved Belkin makes an ethernet-to-USB
four-port hub that seems fairly nice and allows access to many USB devices from any computer on a
network; really a good idea. Ethernet allows a 100m run of cable which can put a telescope a long way
from a warm-room and still be controlled almost completely if a multi-function device such as the
TOGA LX Guider/Focuser or other unit is being used. There are some limitations as to which devices
the hub can control but it runs from 12 V DC so powering the hub should be easy.

Fig. 90
Building a DC power supply to run a unit like this is quite simple which will mitigate most over-current
issues while running cameras etc. For more information see Appendix IV.
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Jon Gunning shot this image of Omega Centauri at the Texas Star Party. The
telescope was an Astro-Physics 130 mm refractor on an A-P 1200GTO
mount. Camera was a Canon 20Da. Twelve 5-minute subs were shot at
ISO800.
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Filters
Filters are one of the most useful accessories that an
imager can add to their kit list and in some cases they are
required. As mentioned earlier in this document for CCD
colour imaging red, blue and green filters will be required
to do any colour imaging. Other filters either filter out
certain wavelengths of light (broadband) or pass only
certain wavelengths of light (narrowband).
Filters come in many formats depending upon their
intended use. The most common in the astronomical
world are the 1.25” and 2” formats with the former almost
always limited to visual observing. These screw into the
bottom of eyepieces, diagonals etc. but are also used in
filter wheels or prime-focus adaptors.

Fig. 91

A recent addition to the filter maker is the 'EOS Clip' from Astronomik (Figure 92) which fits into the
front of a Canon DSLR camera ahead of the mirror. This means that an astronomical filter can also be
used for special effects in terrestrial shooting and also that the same filter can be used for imaging with
both a telescope or a camera lens; truly versatile. It didn't take long for other manufacturer's to get into
the act with their own versions. The most interesting of these is from Hutech which has an adaptor that
clips into the camera body and uses low-profile 37 mm filters.
For those imaging with Schmidt-Cassegrain telescopes, or any other telescope with an SCT thread
attachment most filters are available in a screw-on cell that will mate with the thread.
Filters should be made from proper optical glass, with sides polished plane and parallel then coated
properly for their purpose. A set of filters used for
LRGB imaging should be par-focal (exhibiting no
change in focal point when changing filters).
For ease of use and for allowing remote operation,
CCD imagers that shoot in colour using filters will
use some form of filter wheel such as the one from
Apogee (Figure 93) which mounts ahead of the
camera. These usually holds 4 or 5 filters which can
quickly be moved into place as needed. .

Fig. 92
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Other than the red, green and blue filters are those known as
narrowband filters. These filters block everything but a
specific wavelength such as hydrogen-alpha (Ha), doubly
ionized oxygen (OIII) etc and. are used by CCD photographers
who wish to take specialty images Some will, instead of
taking a 'luminance' image with their CCD will substitute an
Ha image for a different effect... or switch other filtered
images for red, green and blue to try to build a more pleasing
'palette' of colour.
One of the favourite colour sets or 'palettes' as they're knows is
the Hubble Palette. This swaps the light of ionized sulphur
(SII) for red, hydrogen alpha for green and doubly-ionized
oxygen (OIII) for blue. This gives a completely different twist
on deep sky objects.
Fig. 93

Light pollution or High Contrast filters

These filters, also known as broadband filters, are offered by several makers and are all designed to
block the wavelengths of light pollution and possibly enhance the wavelengths or nebulae. Among the
favourites are the Lumicon UHC, Orion SkyGlow and Hutech IDAS Light Pollution Suppression filter.
These are all offered in 1.25 inch, 2 inch, SCT and other formats. Following is a snippet of description
from each vendor's website.
Lumicon Ultra High Contrast filter
...unbeatable for revealing nebulosity. This is achieved by passing three nebula emission linesthe two doubly ionized oxygen lines (496 and 501nm) and the H-beta line (486nm)-while
blocking light-pollution and Sky Glow.
Orion SkyGlow Astrophotography filter
...custom designed the filter to selectively block the specific wavelengths of light associated
with urban sky glow, letting the light emitted from deep-sky objects shine through...
Astronomik CLS filter
...blocks the light of the spectral lines of mercury and sodium-vapour lamps and lets the largest
part of the visible light and H-alpha emissions pass.
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Hutech Light Pollution Suppression filter
...designed to suppress the common emission lines generated by artificial lighting, yet allow the
important nebula emission lines to pass, thus enhancing the contrast of astronomical objects...
Beyond creating a new colour palette narrowband filters can offer significant enhancements of many
deep sky objects. Planetary and supernova remnants often are better imaged with an OIII filter while an
SII filter can offer increased contrast in the deep red for supernova remnants from light polluted skies
with, of course, cameras that are able to record this wavelength. A modified camera is not needed for
OIII. Figure 94 shows an image of the Dumbbell Nebula taken by Robert J. Vanderbei with an OIII
filter.

Fig. 94
One of the most popular filters with both CCD and now DSLR imagers is the Hydrogen alpha filter.
This light which is at a wavelength of 656nm in the deep red. This light, which is the light emitted by
the first transmission in the Balmer series of hydrogen spectral lines is emitted strongly in any areas
where hydrogen is being ionized. There are many deep sky objects that contain a lot of hydrogen that
don't radiate much in visual light but do emit strongly in Hydrogen-alpha (Ha).
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Ha filters come in several forms, each with a different 'bandpass' specification. The least expensive will
transmit a band in the vicinity of 12nm wide while 'tighter' filters can go down to 4 or 6nm. Figure 95
is a monochrome image of the Veil complex in Cygnus I shot with a 12nm EOS Clip filter from
Astronomik in a Hutech modified Canon 500D.

Fig. 95
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HOWTO SECTION
Some tips on things that imagers do to and with their hardware

Alnitak Region by Rick Saunders
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Differential Flexure
The goal of all astro-photographers is to have their target framed correctly, the exposures timed
correctly and to have the stars in the field turn out round. Nice, round stars means that the guider was
working and that there was no shift in the optical/camera system throughout the length of exposure
chosen. Images with oval stars can be caused by several issues but the most common problem is
'differential flexure'.
An imaging system showing differential flexure (DF) has guiding optics and imaging optics that can
move relative to each other. This means that even though the guider may have been locked solid on a
guide star for the whole exposure sequence, the imaging system slowly (or worse, quickly) changed
where it was pointing, causing stars (and everything else) in the image to smear. Differential flexure
can be one of the most exasperating problems to track down but, if approached methodically, it can be
eradicated.
The first place to look for DF is in the method
or methods used to mount both the imaging
and guiding optical tubes. Most have many
different parts which may be from different
sources. This offers much in the way of
versatility but also provides a lot of places
where flexure can creep in. These are:
1. The connection between the imaging
scope's rings and the guide scope's
rings. If a side-by-side setup is in use
this still is pertinent, the scopes are just
offset.
2. The accessory bar on the imaging
scope. Check that it is properly and
tightly connected.
3. The guide scope ring attachments to the
accessory bar. If a dovetail system is
used these should tighten well with
left-over 'slack' when tight.
4. The hinge and locking mechanism for
the imaging tube rings. Again, these
should tighten with a little slack left
over. If they come together compeletely
without properly clamping on the

Fig. 96
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optical tube then the tube can move. If the rings are slightly too large for the optical tube then
they should be replaced or some kind of shim material added so that they properly hold the
tube.
5. The guide-scope adjustment system. The old 'three thumbscrews at 120 degrees' method allows
a lot of adjustment room for finding a guide-star but when set the adjustment screws should be
tight enough to not allow the guide-scope to move at all.
When tightening split-rings never tighten them
enough to compress the optical tube. While this
may sound silly a lot of pressure can be exerted
by a hand-screw.
Loose screws are easily remedied with a hexkey or screwdriver. If it is found that things
loosen over time then the judicious use of LockTite or a similar compound applied to the
threads could keep them in order. Ask a
professional about the use of Lock-Tite as it
comes in various 'strengths'. If there is the
possibility that some day the screw has to come
out then use a type that allows this; some don't.

Fig. 97

If tring mounting clamps don't perfectly tighten onto the accessory dovetail then it might be necessary
to remove some material in the 'slack' that is taken up on tightening to allow the clamps to close farther.
Alternately some shim material between the clamps and the accessory dovetail could be used to get
things tight.
The next place to look is at how the camera is attached to the imaging tube. These days most
astrographs come with some form of easily adjustable focuser. Whether this is a Crayford or a rackand-pinion type there will be a
draw tube that moves in and out of
the focuser to allow the camera to
come to the focal point. If there is
any slop in the focuser the draw
tube could sag over time as the
orientation with reference to
gravity changes. Anything such as
an extension tube between the
focuser and the camera has to be
checked to make sure it can be
tightened properly.
Fig. 98
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The best way to have a focuser set up is to have the draw tube kept well inside the focuser body with
the camera at focus. If the draw tube is mostly exposed then the weight of the camera can cause it to
sag. The use of well-designed extension tubes can allow the focuser's draw tube to stay well supported
inside the focuser. Make sure that the connections between the focuser and extensions are tight and
square.
Some telescopes have rotating focusers that use three
setscrews acting on a dovetail to keep them in place.
If these setscrews are loose enough for the focuser to
rotate then they are loose enough for the focuser to
sag slightly or otherwise move as the mount tracks.
The best thing to do in this case is to lock the rotating
element in place. If camera needs to be rotated to
frame an image then rotate just the camera.
When anything is attached to a telescope there are
usually some thumbscrews involved. Most focusers
these days come with a single tightening thumbscrew
Fig. 99
and a brass compression ring. These rings are there so
that the thumbscrew doesn't mar the barrel of an eyepiece. A single thumbscrew is not optimal for
imaging. Try it; place something in the focuser and tighten the thumbscrew. Try to move it. Many times
it will rock back and forth as it is only contacting the inside of the focuser in two places 180 degrees
apart. This allows motion perpendicular to the line of contact.
This problem can easily be remedied with a drill press and a tap and die set. A second, or better yet, two
more thumbscrews can be added (Figure 98) to allow a proper 3-point contact between components.
The advantage of having three screws is that they allow a tiny bit of adjustment in where an accessory's
centre is located.
If everything isn't tight then adding some force to the end of things
will cause flex. This could be a heavy cable such as those found on
older serial or parallel cameras, or the captive cable on an ST-4
guide head. Heavy cables that hang not only put a force on the end
of an optical train, but a force that could change direction as the
telescope tracks. The easiest way to remedy this is to add some form
of strain relief to the cable run. I use self-stick cable ties on my sideby-side plate to hold up the heavy ST-4 camera cable. The cable is
stiff enough that in the few inches left 'hanging' it provides it's own
organic support. Velcro, cable ties, or duct tape... all are good
sources of strain relief. Make use of them.
In most split-ring systems the rings have some form of backing
which allows the telescope to be clamped in place tightly while not
marring the tube's finish. Cork and felt are two common materials
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Fig. 100

used but both can display some small amount of give when a telescope tilts over. These materials can
be removed and replaced with some .020 or .030 flexible plastic material from a hobby store. It only
needs to be flexible enough to go around the curve of the rings. Hold the plastic in place with contact
cement, this will not come apart and can take the changes in temperature that the system will be
subjected to.
If an imaging tube is a Cassegrain type where the mirror moves on the central baffle (Figure 100) in
order for the system to reach focus, a major source of flexure can be mirror-flop. On older SCT and
MCT systems the mirror rode on a carrier that moved back and forth on the baffle with only a layer of
lubricant to provide support. The few thousandths of an inch between the carrier and the baffle could
cause an image to shift upward of 30 arcseconds.
New SCTs generally have pre-loaded ball-bearing carriers and may even have a mirror-lock to keep the
mirror from tipping as the scope tracks. These can work very well but they then require an external
'zero image shift' focuser to add the needed adjustment. There are many of these on the market, any of
which can add their own flexure
issues.
In all instances when making parts
eschew wood, soft plastics, rubber,
etc. Make any parts out of aluminum
or steel: something that won't
compress, shift, shrink, grow or
move.
As I mentioned at the top chasing
down differential flexure can be a
chore and very exasperating at times
but the quality of images from a
solid, non-flexing system is well
worth the trouble. Just remember...if
it is supposed to be tight, then
tighten it.

The East Veil shot by the author with a Canon/Hutech 500D and
AstroTech 8” Imaging Newtonian on a Celestron CGE mount.
Ten 7-minute exposures at ISO800.
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Polar Scope Alignment
Every mount that has a polar-alignment scope should have some method of aligning it with the polar
axis in order for it to be of use. Generally, this is not a difficult procedure and is most likely outlined in
your mount's user manual but I'll run through it quickly.
Most of the polar scopes that I've seen use three setscrews spaced 120 degrees apart to set their reticule
alignment. All had a cross-hair or an X the centre of the reticule that indicates the true celestial pole and
which is to be used while aligning the scope.
Start by picking a distant target, something like the insulator on a power pole. Point the polar alignment
scope at the target with the counterweight shaft horizontal. Adjust the mount's altitude and azimuth
adjustments to place the cross-hairs on the target. Now, swing the counterweight shaft over to the other
side of the mount.
The cross-hair will now be off target in some direction (unless the polar scope is already aligned) so
use the reticule adjusting setscrews to move the cross-hair ONE HALF the distance back to the target.
Then flip the counterweight shaft over to the other side and use the alt/az adjustment to put the crosshairs back on the target. Repeat these steps until the cross-hairs stay on target while the counterweight
shaft is flipped.

Fig. 101
Once the polar alignment scope is adjusted there may be date and time rings to adjust; these are outside
the purview of this document as no two makes of scope will use the same method.
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Telescope Balance
Some people spend an inordinate amount of time balancing their telescope and all of the equipment that
it carries. Normally, as a German equatorial mount should not be pushed much more than 50% of the
rated capacity for imaging, there is actually some leeway with balance. And this is a good thing
because perfect balance is not what should be the goal in many cases.
An equatorial mount runs at sidereal speed while tracking the sky. When a guider (either manual or
computerized) makes corrections in right ascension it either speeds up the mount's tracking or slows it
down. The direction that the mount is moving never actually reverses so there is no issue with backlash
in right ascension. The goal to be achieved then is to have the worm and gear always engaged. The best
way to do this is to have the mount balanced east heavy in right ascension. Figure 102 demonstrates
this principle.

Fig. 102
The new weight positions shown will always have the telescope balance heavy east. Don't forget that
after a meridian flip the counterweight will have to be repositioned.
Setting the optical tube nose heavy allows a worm-to-gear engagement in declination much like the
east-heavy setup of the RA axis and is better than perfection in balance which may let the tube 'float'
between the leading and trailing teeth of the worm gear. If needed a weight of about 2 kg could be
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made that is adjustable on the optical tube allowing the balance to be heavy either way by moving the
weight.
Along with a nose-heavy tube a mount can be slightly misaligned so that declination drift occurs in a north-only mode
by setting the RA axis slightly west of north (looking north)
and just past north (between the pole and the northern
horizon). With this alignment the mount never reverses
direction in declination removing declination backlash from
the guiding process. Now, by 'slightly' I mean perhaps 10-15
arc minutes which is all that is needed.
I've found that my side-by-side unit does a very good job of
providing a balance offset in declination for those times that
the tube is pointed at or near the zenith. I just keep the SBS
heavy on the guide-scope side and it keeps the declination
gears engaged.
Fig. 103
Fork-mounted telescopes generally don't come with any
system for balance but there are several after-market setups that can be purchased, some of which are
quite complex and allow '3D balancing'. Most are just a small dovetail or bar with a sliding weight such
as the one from AstroEngineering in Figure 104. Adjustable weights are something that would be a
good idea on any optical tube.
Be mindful that a mount has to be balanced with ALL of the gear that will be used in place. Don't
balance before adding a camera, guide-camera, cabling etc. Also be cognisant of any changes in
balance while slewing and tracking especially if there are off-centre loads such as when using a sideby-side setup.

Fig. 104

84

Drift Alignment
Having a good polar alignment is necessary for astro-photography and there are several methods of
achieving this. Polar alignment scopes and software routines make it simple to achieve anywhere from
reasonably close to almost dead on in polar alignment but not everyone has access to these. In this case
the method to use is called 'drift' alignment; so called because it uses how a star drifts in a reticule
eyepiece to adjust the polar axis precisely.
A good starting point is very helpful so start with a compass (properly set for magnetic deviation) and a
level to get the mount close to being aligned.

Fig. 105

Fig. 106
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Now select a star near the meridian close to the celestial equator and put the star in the reticule
eyepiece and watch it for several minutes to watch for any drift. If it drifts north then the polar axis is
pointing too far east if looking south. If the star drifts south then the axis is pointing too far west if
looking south. Adjust the axis and re-centre the star. Continue until the star 'rides' a cross hair for 15
minutes.
Now select a star in the east near the horizon and around the celestial equator. Put the cross hair on it
and again watch it for drift. If it drifts north then the RA axis is above the pole (between the pole and
the zenith). If it drifts south then the axis is below the pole (between the pole and the north horizon).
Adjust until the star again rides the cross hair for 15 minutes. Then go back to the meridian because
things there will have gotten out of kilter.

Fig. 107

Fig. 108
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The drift alignment method has the ability to put a mount dead-on the celestial pole. It is more useful
for permanently mounted telescopes but I've done it for scopes that won't move for a few days. Other
than that I've found that the alignment routine in my CGE's firmware can get me very close in a short
time.
Notice that I said in the beginning that a 'good' polar alignment is necessary not a 'perfect' polar
alignment is necessary. For the short subs that many people take good is fine as there won't be any
noticeable field rotation in that short time. Also, remembering the mis-alignment mentioned in the
previous section to allow easier guiding one may not want a perfect alignment.

Image by the author of M27 taken with an unmodified Canon Rebel XT
mounted on a Celestron C8 at f/6.3. Ten 5-minute images at IS800.
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Exposure Control
Once everything is setup, aligned and it's dark out it's time to start
taking images. This means that some method of exposure control
has to be in place. Whether this is simply a manual remote and a
wrist-watch (not too accurate) or something a bit more complex
the shutter has to open and close when needed. Those using CCD
cameras will have the camera control software running on a
computer so I won't dwell on these and move on to DSLRs.

Fig. 109

DSLR cameras generally have some method of triggering the
shutter remotely. This can either by via infra-red remote, standalone cable release or via a USB connection. I'll spend a few lines
discussing the first and last of these and most of the time on the
cable release.

Infra-red remotes allow operation of the shutter of some DSLRs using the IR port on the front of the
camera. These can be expensive but a universal TV remote can be programmed to do the job
(really...I'm not making this up). There are sites on the WWW that will explain the process for any
specific camera.
Controlling the camera via a USB connection using something like Canon's EOS Utilities turns a
computer into an intervalometer. If there is a computer at the
telescope anyway there's not really much reason not to use
the software that is provided.
If no computer is available a manual cable release can be
used if is supported by the camera or an electronic
intervalometer such as the Canon TC-80 (Figure 109),
Nikon MC-36 or the camera-neutral TOGA Intervalometer
(Figure 110) can be used. Each of these will allow a series of
exposures to be programmed in for an automatic sequence.
Canon's TC-80 won't work with the Rebel series without
modification and the Nikon unit is only for some of their
cameras though they might offer other models of
intervalometer that function with other models.. The TOGA
device will work with any of them.
Nice things to look for in an intervalometer are the ability to
do mirror lock up, programmable prefocus time and
sufficient battery life to run a long imaging session.
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Fig. 110

Collimation
Any telescope system needs to be in collimation. This means that all of the optical components and
their mechanical adjuncts are all properly aligned. Refractors generally don't need adjustment and with
many it isn't possible . Any reflector will have the ability to be properly collimated.
A well collimated telescope will display sharper,
more contrasty images and will allow dimmer stars
or objects to be photographed. An example of an
out-of-focus star image both out of collimation and
in collimation is shown in Figure 111.
There are many different tools that are on the
market to help properly collimate a telescope.
These can be simple or quite complex. A précis of
a few of them follow:

Fig. 111

A collimating cap
This cap can be as simple as a 35 mm film can with a small hole drilled in the centre of one end
that is put in the focuser and looked through. Better is a 1.25” cap with a hole in it put onto a
1.25” eyepiece barrel such as in Figure 112. These are mostly used to properly orient the
secondary mirror of a Newtonian reflector.
A sight tube with cross-hairs (Cheshire or not)
These are very versatile tools but shy away from the cheap, plastic ones. If the sight tube is
short enough this can double as the above-mentioned collimating cap. A Cheshire tube can, on
its own, collimate a Newtonian reflector to a very high degree of accuracy if one's eyes can
accommodate focusing very near and middling far. A Cheshire sight tube is shown in Figure
113.

Fig. 113

Fig. 112
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A barlow lens
Any old barlow will do: single-element, achromatic or multi-element. Stick with an actual
barlow though, as I don't know how this procedure will work with a TeleVue PowerMate unit.
They're technically not barlows.
A laser collimator
A good one. I've gone through two inexpensive lasers that weren't themselves collimated and
therefore, other than for use with a barlow (explained later) pretty much useless. The Hotech
self-centring laser (Figure 114) is very nice as are any of the units from Howie Glatter.

Fig. 114
Auto-collimator
This is a small plug that fits in the focuser with a centre hole. Inside is a plane, polished
reflector. It all works like those mirrors in old barber shops where you see multiple reflections
stretching into the distance. Between the collimator and the primary mirror you get multiple
reflections and if there is any mis-alignment this can be corrected by adjusting the primary
mirror until all the reflections coincide.
The least expensive, yet very accurate Cat's Eye passive auto-collimator system has gottenrave
reviews in Cloudy Nights and other venues.

Newtonian Reflector
There are several parts to the basic Newtonian that all have to be aligned both mechanically and
optically in order for the telescope to deliver the best image. Collimation starts from the eyepiece and
works its way out so the first thing that must be looked at is the placement of the focuser and the
secondary spider. These are both beyond the scope of this document as we'll assume that the focuser
and secondary spiders have been properly installed.
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First in the sequence of collimation is the aligning of the the secondary mirror. This has to be properly
positioned in the optical tube to be able to pass the maximum amount of light from the primary mirror
up the focuser.
To check on the positioning of the secondary mirror
use a collimation cap as shown in Figure 112 (or a
Cheshire sight tube). Looking into the telescope with
the cap in place the secondary mirror should appear
round and perfectly centred in the focuser. Most
secondary mirrors can be adjusted along the optical
path to centre by loosening a large central screw in the
secondary holder. Once it is centred then the
collimation cap is swapped for either a Cheshire tube
or laser. I'll discuss the laser first.
Place the laser in the focuser and turn it on and look
down the telescope towards the primary mirror. A laser
dot should appear on the mirror. Adjust the three
collimating screws in the secondary holder (don't
touch the large central screw) to move the laser dot
into the 'doughnut' on the primary mirror (Figure 115).
Fig. 115
All Newtonians these days have central spotted
mirrors but if your's doesn't you'll need to put one on by removing the main mirror, finding the centre
and sticking on one of those paper reinforcements from a stationery store.
Once the secondary mirror has been aligned then it is time to move to the primary mirror. The mirror
cells of all Newtonians should have 'push/pull' screws to properly orient the mirror. If the telescope has
a truss tube then a short collimator such as those from Howie Glatter that protrudes from the focuser
inside the telescope and is visible from the rear can be used.

Fig. 116
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If the telescope is a solid-tube type then a laser unit as shown with a
cutout that can be seen from the rear can be used. Either way the
idea is to adjust the primary to get the laser reflected back directly
into the hole that it came out of (Figure 116 left).
The 'barlowed laser' method is also very effective. This method not
only removes from the equation any mis-collimation of the laser
device but also any 'slop' in the focuser. To do this, once you have
aligned the secondary mirror take the laser out, insert it into a barlow
lens then replace it in the focuser. Now the laser will illuminate the
area around the central doughnut on the main mirror and reflect back
the shadow of the doughnut as shown in Figure 116 (right). Adjust
the push/pull screws to centre the doughnut's shadow.
Using a Cheshire sight tube such as the one shown in Figure 113
allows for a very accurate alignment of a Newtonian's optical path.
The device is placed into the focuser and the alignment is checked by
looking at the image seen of the various optical components.
To start with nothing is aligned (Figure 117 top). Place the Cheshire
tube in the focuser and look in through the peep hole. The secondary
(lilac) is not properly positioned so loosen the large central screw on
the secondary holder (check the telescope's documentation) and
move the secondary so that it is perfectly centred in the Cheshire
(Figure 117 second graphic).
Now adjust the collimating screws on the secondary so as to put the
cross-hairs on the primary mirror's (red) centre spot (Figure 117 third
graphic). The green circles are the shadow of the secondary and
Cheshire. The grey circle is the primary mirror with its hold-down
clips.
Now adjust the primary mirror's adjustment screws or knobs until the
shadow of the secondary and Cheshire are under the cross-hair
(bottom graphic). Don't worry if the shadow of the secondary
appears off centre. It is supposed to be.
With the view through the Cheshire as in the bottom picture at the
right a Newtonian telescope will be in very accurate alignment.
Today's fast Newtonians being used with coma correctors require a
high degree of collimation accuracy. Either a laser or Cheshire will
allow this level of accuracy to be achieved.
Fig. 117
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Schmidt-Cassegrain
Schmidt-Cassegrain telescopes (SCT) generally don't
have any method of aligning the primary mirror and
therefore only the secondary needs adjusting.
To properly collimate an SCT really requires a star but
there are devices on the market such as the Hotech
Advanced CT Laser Collimator that can accurately
align an SCT indoors during the day. There is a fine
video on Hotech's website of how this device works
but I'll stick to something a bit simpler.
To start the collimation process on an SCT first set the
telescope up so that you can comfortably sit and look
down the tube from the front at a distance of about 2
focal lengths from the corrector plate. Centre yourself
in front of the secondary holder and look at the
'circles'. These will be the edge of the front cell, the
Fig. 118
primary mirror, a reflection of the secondary, etc. If
properly collimated they will be concentric. In an uncollimated SCT the view will be something like
Figure 118.
Adjust the three collimation screws in the secondary holder until all of the circles are centred and
aligned. When this is done the rough collimation is complete and it is time to head out and find a nice
2nd magnitude star. Polaris is a good choice.
Select an eyepiece which gives a good amount of magnification and put the star in the field, centred
and slightly de-focused. The star must be in the centre of the field and it must be returned to the centre
of the field after each adjustment.
In an un-collimated SCT the out-of focus star will show the shadow of the secondary mirror off-centre.
Figure 119 shows the star both focused (centre) and either side of focus in an un-collimated telescope.

Fig. 119
With some SCTs collimation may be a two-man job with one person looking at the star and the other
adjusting the collimation screws. Bob's Knobs, which are thumbscrews that replace the phillips or hex
screws, make collimation simper and allow one person to collimate smaller SCTs.
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The outcome is to have the shadow of the secondary centred to a high degree of accuracy. It takes
practice, but once it has been done a few times it becomes second nature.

Maksutov Cassegrain
Maksutov Cassegrains (MCTs) are much like SCTs except that most have the secondary as only an
aluminized spot on the front corrector plate. These will have push/pull collimation screws in the cell
that holds the corrector and which allows the collimation of the telescope. Some MCTs do have
adjustable secondaries and primaries but these are not the norm.

Image of the Pacman Nebula, NGC281 taken by the author. Captured with a
Canon/Hutech 500D mounted on an AstroTech 8” imaging newtonian on a
Celestron CGE. Ten 5-minute images at ISO800.
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Flat Frames
There are seldom times when an
optical system put together from
many parts works perfectly out of
the box. One of the problems that
crops up in astro-photography is
due to imperfections in the
illumination of the sensor. This
could be due to vignetting (light
being blocked), light falling off at
the corners due to the design, dust
on the sensor or even pixel nonuniformity.
To remedy the above problems a
flat field frame is taken which is
Fig. 120
then divided into the image frames
to boost areas that are under-illuminated. A typical flat frame might look like the Figure 120 which
shows fall-off at the corners and a few rings caused by dust motes. Once the images have been
processed with the flat frame the imperfections will be gone from the final product.
The flat frames should be taken with the equipment setup as if to image and a new flat frame, or set of
flat frames, should be taken each imaging session. Some people develop a library of flats but those
won't mitigate the effect of any stray dust that lands on the sensor between sessions.
Flat frames are quite easy to take just after sunset before an imaging session. Of course, the sky will be
cloudless which means that it has no visible structure and will generate a flat field when photographed.
Point the telescope about 20 degrees from the zenith exactly opposite the point of sunset and shoot a
series of pictures. These will be your flat frames.

Fig. 121

The flat frames have to be exposed nicely which means
not burned out or too dark. I've found that with my DSLR
set at the ISO value at which I'll be shooting the target I
adjust the shutter speed to give me exposures that are
about 1/3 histogram. With a CCD camera expose for 1/3
of maximum value. A 1/3 histogram is shown in Figure
121. With the stacking software I use (DeepSkyStacker)
this seems to give about the best result. Some people
place a layer of white t-shirt material over the front of
their telescope when shooting flat frames of the sky but I
have found that this really isn't needed.
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For taking flat frames anytime a
light box can be built which can
be
illuminated
with
an
incandescent bulb or other light
source. There are as many
different designs for light boxes
as there are people building
them. A good representative
example is that which Greg
Pyros,
an
imager
from
California,
has
constructed
(Figure 122). His light box has
inserts or cutouts to allow it to be
used with several telescopes and
lenses and his website has full
plans and a bill of material (see
the Links section).
If building a light box is out of
Fig. 122
the question a laptop or computer
monitor or perhaps an electro-luminescent panel can be put to use. To use a laptop first set up a white
background such as an empty word processing page. Then place the telescope on a tripod or other
stand so that the front can be placed flat against the screen with a layer or two of t-shirt material
between them. Once setup, a series of as many flats as needed can be shot, again to about 1/3
histogram. Use a 12 V electro-luminescent panel as an illumination source in the same way.
Figure 123 shows how David Haworth of
Oregon sets up his Pentax refractor for
taking flat frames from his laptop. Notice
that he uses a sheet of white plastic
between the screen and the telescope as a
diffuser instead of t-shirt material (see
the Links section).
So as not to do any damage to the screen,
or kill any pixels, don't force the
telescope into the LCD .

Fig. 123
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Dark Frames
While modern CCD or CMOS cameras are wonderfully low-noise, when shutters are open for long
periods of time noise will creep into the images. This can come from internal or external sources and to
fight this astro-photographers shoot dark frames. A good starting place for this section is to look at
some of the sources of noise.
Read Noise
Read noise is a fundamental characteristic of any sensor and is generally caused by non-photongenerated electrons read by the camera's amplifiers.
Dark Current
Sensors build up current whether or not photons are impinging upon them, this is because the
sensor is 'hot'. Cooled sensors show less or none.
Random Photons
This effect is mostly seen in dark areas of images where few photons show up. Photons, being
quantum beasts, aren't always predictable. The probability of the arrival of single photons over
time is actually a Poisson curve.
Amp Glow
Amplifier glow is generally manifested in DSLR cameras. The signal that comes from each
pixel on a CCD or CMOS sensor is very small. This has to be passed through an analog-todigital converter and then an amplifier in order to be useful. The amplifiers can become hotter
than ambient and add a thermal noise pattern to an image. On Canon DSLRs this showed up as
a red area in the lower right corner of an image and resembled sky-glow.
Fixed Pattern Noise
Fixed pattern noise is commonly seen as 'hot pixels'. These are pixels in a CCD or CMOS
sensor that stay on and bright causing white dots on monochrome images or coloured dots on
colour images. They don't move (hence 'fixed') from shot to shot. Conversely, a pixel may be
dead and cause a completely black dot on either monochrome or colour sensors.
Random Noise
Intensity changes in pixel output introduced along the electronic path from the sensor through to
the amplifier cause this effect.
Banding
This type of noise is mostly seen in CMOS sensors. Horizontal or vertical bands which appear
when an image is shot using high ISO values and where the histogram is stretched excessively .
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All of the above mentioned noise sources can conspire to reduce the signal-to-noise ratio of your
images to the point where the target becomes difficult or impossible to dig out of the muck.
Fortunately, today's sensors for the most part display low levels of many of these sources.
Whatever the source in the above list the one solution generally used to fix the problem is to take one
or several dark frames. These are taken with exactly the same exposure settings as the image frames but
with the shutter closed (CCD) or with a lens or dust cap in place (DSLR). A dark frame will read all of
the same sensor noise as the image frames. During processing the noise recorded can then be removed
from the actual images.
Figure 124 is an example of a 5 minute dark frame taken at ISO400 with my old Canon 350D. It has
been stretched excessively to bring out some of the noise. Notice the amp glow at the bottom right, the
banding in the image and, underneath that there are some hot pixels (shown in the inset)

Fig. 124
I generally take 5 to 10 dark frames while I'm tearing down my gear after a night of imaging. If the
temperature is changing rapidly I'll take my dark frames in the middle and end of the session. A library
of darks can be built for different temperatures, but pixels come and pixels go which means that they
might not be valid forever.
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Light Frames
Light frames are those have a target framed and are capturing actual image data. In the world of DSLR
imaging many light frames are generally taken and 'stacked' together to provide a final image.
Images are stacked are to increase the signal-to-noise ration (SNR) and the dynamic range of the final
image. The section on Dark Frames discussed how to these are used to remove fixed pattern and
thermal noise but darks will not remove random noise. Stacking does this.
Stacking is a pixel-by-pixel process. Consider a single pixel in the sky background of an image. There
is nothing in that pixel emitting photons so the pixel should be dark. Once in a while though, a random
photon might strike that pixel releasing an electron in the sensor which is then counted and raises the
value of that pixel. If only a single image was taken then that pixel would not be the same as all of the
other background sky pixels surrounding it. It would become noise. With the mean of several images
being used to provide the pixel value for the final image then the effect of that random photon is
diminished or even removed. The more sub-images (subs) that are in the stack, the lower the mean
value will be if only one image in the stack shows that photon hitting the sensor.
Dynamic range is the spread between the lowest pixel value in an image and the highest value.
Stacking images allows the dynamic range to be increased by keeping the low end of the range as low
as possible. This is accomplished by keeping exposure times short enough to not allow light pollution
or other non-sky lighting to give the sky background a large value. This brightening of the sky with
increased exposure is known to imagers as 'sky fog' and generally manifests itself as a red glow
pervading part or all of a sub-image.
Sky fog places a limit on how long the
shutter can be left open. There are many
complex equations that can be performed
to determine the longest exposure time
that can be used but complex equations
can be problematic in the field. Here is a
simpler determination method: expose
until you reach about ½ histogram is
reached on the camera. The ½ histogram
rule is not carved in stone but it's a good
starting point. The histograms on most
DSLR cameras are logarithmic so ½
histogram is really not a large value for
the sky background. Figure 126 shows a
graphic of the relationship between a
linear histogram (left) a histogram of the same image in logarithmic mode (right).
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Fig. 125

CCD imagers handle sky-fog in the same manner as DSLR imagers by limiting exposure time. They
can actually calculate their exposure times using an on-line calculator such as the one at
http://starizona.com/acb/ccd/calc_ideal.aspx. This calculation is possible as all the needed camera
specifications are available to them. A test image is taken and the value of the sky background is
measured. Applying the calculations from that value can determine the best exposure.
Another variable for the DSLR imager is the ISO setting. Increasing the ISO setting on a DSLR
increases any noise in an image as the amplification of the signal from the sensor is boosted by a fixed
amount for every step increase. At high values this actually tends to 'squeeze' or limit the dynamic
range of the image. All cameras have an ISO 'sweet spot', that setting where the most data can be
collected with the least amount of noise. With all cameras being different the only method of
determining the best value to use is to shoot several images with different values and compare the
output. CCD imagers do not speak in terms of ISO but in 'gain', a value which can be adjusted on some
cameras.
Most DSLRs allow for RAW images to be taken. These contain minimally-processed data from the
sensor and may have a higher dynamic range or colour gamut than a JPEG or TIFF image. JPEG
processing may even create processing artifacts. CCD imagers generally work with FITS (Flexible
Image Transport System) files. This file type was designed for scientific images.
Many DSLR cameras these days allow for in-camera noise reduction which is wonderful for shortexposure, terrestrial photography. Imagers generally handle noise during the processing phase using
dark frames so the in-camera method is not needed. CCD cameras do not have this provision.
On DLSRs the exposure should be set to 'bulb'. This means that the shutter will remain open as long as
the shutter button (or remote release) is pressed. Controlling exposures is discussed in the Exposure
Control section.
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PROCESSING SECTION
Some tips on processing the images collected

Lagoon and Trifid by Jon Gunning
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Stacking Images Using DeepSkyStacker
Once a collection of the light (image), dark and flat frames have been compiled something has to be
done with them. The darks and flats have to be processed master images and then subtracted from or
divided into the light frames. The light frames then have to be registered and stacked. This can all be
done manually using just about any graphics manipulation package, but there is software available that
will do all of this work automatically, and well.
The software that will be discussed here, and arguably the most popular freeware stacking package is
by Luc Coiffier and is called DeepSkyStacker (DSS). This easy to use package can do all of the
stacking and registering needed.
DSS will take as input RAW files generated by most digital cameras along with JPEG, TIFF and FITS.
I generally work with RAW data as it has not been altered by the camera's processor and will be free of
any artifacts that may come from this type of internal processing. DSS also appears to like RAW files
better than the JPEG files my Canon creates.
The DSS work space is in a single window and Luc has eschewed the normal menu list across the top
for a column of actions running down the side as seen in Figure 127.

Fig. 126
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The work flow in DSS runs generally from top to bottom in a
logical sequence, therefore the first thing that has to be done is
to load the files to be worked on into the software starting with
lights by clicking Open picture files. This will bring up a file
selection dialog that is used in the standard Windows manner.
The same with dark files, flat files, etc.
When all of the files have been loaded the file list can be saved
for later use, or if there is already a list saved it can be loaded
directly through the Open/Save a File List actions. Also, to start
fresh a flie list can be cleared.
Once the files have been loaded click on the Check all item.
This will select all of the images in the list for processing. There
is a possibility that some images will be removed in the future,
but for now DSS has to have access to all of them.

Fig. 127

Once the images have been checked right click on the first light image and check 'Use as reference
frame'. This will be the image that DSS checks each succeeding image against.
From this point DSS has to check each image and determine several properties. It will calculate how far
from the reference image each is in X and Y axes and in rotation. It also checks for the roundness and
focus of stars and will display the FWHM for each image and assigns each a quality value.
To do this, with all of the files checked click on the Compute offsets action. The work being done will
take some time but when it is complete the file list at the bottom of the window will be fully populated,
as partially shown in Figure 129. At this time the
image attributes can be inspected line by line and a
decision made as to which images will be included in
processing the final output image or discarded.
As can be seen each image in this list is 'drifting' in
X, Y and rotation from the reference frame; most
probably due to differential flexure. Most light
frames only deviate from the previous one by a pixel
or two but there may be a few large jumps in the list.
The files with the large jumps will be too heavily
smeared to use so they should be discarded.
Even if the stars aren't blurred the image may be out
of focus or some thin cloud may have partially
obscured the light. This will show up in the Score
Fig. 128
column by showing a number that is far below the
average. If I see a problem I usually open the image in Digital Photo Professional to check it out.
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Fig. 129
Once the file list had been pruned it is time to register and stack the images which is done by clicking
on the Stack checked pictures item. Now it is time to go have a coffee, watch a movie or something
else that will take up time as it can be a lengthy process. DSS automatically combines your dark and
flat files into a master dark and a master flat and will use these in further processing. They are saved in
the directory that they were chosen from.

Fig. 130
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Now stacking is finished and DSS displays the final image for processing in DSS. I generally don't as I
prefer to use PhotoShop or the GIMP.
The final image is saved in the same directory as the light frames were and is called Autosavexxx.tif.
The xxx are numbers 001, 002 etc. as there may be more than one in the directory. They are in the
format of a 32-bit TIFF image. To save as a 16 or 32-bit TIFF or a 16 or 32-bit FITS file click Save
picture to file. I generally use 16-bit images and knock them down to 8-bit later.
I use Canon RAW files exclusively for all my images: light, dark or flat. To configure how DSS uses
RAW or FITS files click on Settings->Raw/FITS DDP settings to bring up the settings for that file
type.

Fig. 132

Fig. 131

I've found that with my two Canon cameras that nothing has to be changed in the RAWS dialog. The
only thing I can think of that I might play with is to use the white balance from the camera as my
Canon has been modified and I do use a custom white balance.
DSS can also provide a lot of recommended settings based on its analysis of the file list. These are
accessed by clicking on Settings->Recommended. The dialog in Figure 133 shows a list of things that
DSS has noticed and what it recommends to do. To do it just click on the underlined link.
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Of course, access to all of DSS's
multitude of settings is available by
clicking on Settings then selecting
either Register or Stacking. Register
brings up the star detection dialog with
a slider. Selecting too few or too many
stars can alter the registration process.
I leave mine at around 40%.
To have access to the rest of the
settings that DSS has available select
Stacking from the Settings list. This
opens up a multiple-tab dialog that
allows adjusting just about everything
in the software. I leave most things at
default but have tested a few of them,
generally to my chagrin.
Fig. 133
DSS has quite an active Yahoo! group
which, if one is going to use the
software, should be joined. There is also on-line documentation on every option.
To download the latest software or to go over the documentation the URL is below.

http://deepskystacker.free.fr/english/index.html
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Stacking Images with IRIS
IRIS is a powerful image registration, stacking
and processing software package that, unlike
DeepSkyStacker will work perfectly in a virtual
PC and is available to be downloaded free. This
software, written by Christian Bull, does not
have the ease of use exhibited by
DeepSkyStacker but it is much more versatile,
Fig. 134
especially in the area of pre-stack processing.
IRIS is also fully scriptable allowing for automation to be built-in if needed. This section will only
cover the process of registering and stacking a set of images.
IRIS works either with a typical Windows set of menus and icons and also has a 'command window'
where internal processing commands can be typed in to perform various tasks. On startup of the
software the command-window should be opened
which is done by clicking on the icon indicated in
Figure 134. The command window shows a > prompt
(Figure 135). Commands are typed in and executed by
hitting the ENTER key.
IRIS wants (requires at times) a full set of images: light,
dark, flat and offset. Other than the light frames these
Fig. 135
can be 'faked' if there were none taken. The creation of
a 'pseudo-offset' image will be described as I had none on hand. The rest of the images used in this
document are from an actual imaging run.
IRIS works internally with PIC, FTS or FIT files and any
images taken that aren't in either of these formats will
have to be converted. Lights, darks, flats, etc. should all
be converted separately. The picture type that IRIS will
use, along with some useful directories, should be set on
start-up by using clicking on the FILES->SETTINGS
menu item. This will open up a configuration window
(Figure 136) where the needed values can be entered.
These are saved from one processing run to the next.
There is no difference to the software which type is
selected. I use PIC for no other reason that it is what I
selected when I first started playing with IRIS and I
haven't seen the need to change. Also, an empty directory
to be used as the working path should be set. This is
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Fig. 136

where IRIS will store any intermediate or temporary files. After a processing session this should be
cleaned out.

Fig. 137
IRIS can work with the RAW files from most digital SLR cameras along with most formats generated
by other cameras and software. Before it can work with the RAWS though they must be converted to
one of the file types set forth in the configuration dialog.
IRIS uses 'generic' names in it's processing for both input and output. As it normally is given a
sequence of images it will automatically append a number onto any generic name. In the work flow the
generic output name is generally the next task's generic input name.
To start file conversion select DIGITAL PHOTO->DECODE RAW FILE from the menus. This will
close the main IRIS window and open a Decode Raw Files window. Next open up a Windows Explorer
file list for the directory where the RAW files reside. Drag the required files into the decode window
(Figure 137). Once the Decode Raw Files list is populated put a generic name for converted files in the
'Name' box (circled) and then click the CFA button. I suggest using 'light-' for the light frames generic
name, 'dark-' for the dark frames and 'flat-' for the flat frames. For example, the first light file,
IMG_0019.CR2 will be renamed to light-1.pic (or FIT etc.) When the CFA button is clicked a progress
dialog will open. Repeat the procedure for darks, flats and offset files.
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Once all of the files have been converted master dark, master flat and master offset files have to be
created. I don't generally shoot offset files but IRIS wants one so a 'pseudo offset' has to be created
which can be done using the tools available in the program. To create the file one of the light frames is
loaded into IRIS, filled with the value 0 (black) and saved. In the command window the following
commands are entered:
load light-1
fill 0
save offset
The creation of a master flat and master dark (and a master offset if you've taken the frames) are pretty
much the same procedure. The sequence to create a master dark starts with selecting the menu item
DIGITAL PHOTO->MAKE DARK which will open a dialog window (Figure 138). Enter the generic
name of the dark frames (dark- in our example) and set the number of darks that were taken. The Offset
box should already have 'offset' entered, which is the name I chose for the pseudo-offset file. Clicking
OK will bring up a progress dialog. The same procedure is used for flats, DIGITAL PHOTO->MAKE
FLAT FIELD (Figure 139) and offset DIGITAL PHOTO->MAKE OFFSET.

Fig. 139

Fig. 138

The master files are not automatically saved by IRIS. When the task of making a dark or
making a flat-field is done a save command must be typed into the command window to
save the image. For the dark type 'save dark', for the flat type 'save flat' and for the
offset (if you made one) type 'save offset'.
With a master dark file on hand it is now possible to create a cosmetic file. This is a list of sensor
defects that IRIS uses to repair an image. The simplest way to create the list is to go to the command
window issue the following commands:
load dark
stat
find_hot cosme THRESHOLD
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To determine the value of THRESHOLD that should be used look in the Output window and calculate
Mean + ( 16 x Sigma)
These will load the master dark that was created earlier, then find any pixels that have a value over a
threshold of 300. The positions of these will then be stored in a file called 'cosme.lst' for use in the next
step, pre-processing.
There are now a full set of images ready for further processing by IRIS. The first thing that has to be
done with them is to pre-process the light images with the master flat, master dark and master offset
files. To start this one of the light frames has to be loaded by going to the command window and
typing:
load light-1
Now use the mouse to create a box somewhere in a star-sparse area of about 200 to 300 pixels (Figure
140). This is done by clicking in a dark location and dragging the mouse to create the needed box. This
zone is used by IRIS to compute the optimal dark. Next the DIGITAL PHOTO->PREPROCESS

Fig. 140
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menu item is selected which opens a dialog box. Fill in the generic names of the light images, master
dark, master flat and master offset. These last three are the names given earlier when they were created:
flats, darks and offset and check the Optimize check box.
In the bottom entry box titled 'Number' should be the
number of light images that will be processed.
Clicking OK starts the pre-processing.
Once the images have been pre-processed it is time
to convert them into a colour format if they are the
product of a DSLR or other colour camera. The PIC
or FIT images that IRIS has been working with up
until now are monochrome and they should be in
their colour version to stack. To convert to colour
select the DIGITAL PHOTO->SEQUENCE CFA
CONVERSION menu item which will open up the
dialog box shown in Figure 141.

Fig. 141
Converting to colour takes as input the calibrated files we've called 'light_calib-' and outputs colour
files that we'll call 'light_colour-'. The number entry should be correct but make sure that it is and in the
bottom row check the 'Color' radio button..
With the files now ready to register and stack any further prestack processing can now be done. IRIS can do things like
applying an unsharp mask or white balance adjustment to the
whole sequence indivitually. For now select PROCESSING>STELLAR REGISTRATION from the menu list. This will
open another dialog box (Figure 142).
In this dialog box enter the generic input name of the colour
files (in this case light_colour-) and enter a generic output
name. Here I've used 'light_registered-'. Again, IRIS may have
the correct number entered but it is a good idea to check this
and correct it if needed.
There are several methods available some of which are faster
and less accurate than others. I always use the 'Global
matching' method which looks at all the recognizable stars in
the image. The transformation that I use with this is 'Quadratic'.
This means that it will take some time to register the images so
once 'OK' is clicked it might be a good time to go for lunch. No
progress bar is provided here but the IRIS title bar shows which
file is being processed.
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Fig. 142

With the images registered there is only a single major task left which is to stack the registered images.
Again in the PROCESSING menu select the ADD A SEQUENCE item (IRIS doesn't call it stacking
but calls it adding). This will bring up the last dialog box (Figure 143) where again a generic input
name and the number of images are asked for. The input name will be the output of registering, or
'light_registered-' and once again the number of images is 10.
The 'Normalize if overflow' check box will, if checked, tell IRIS to adjust the stacked image's
brightness if stars become saturated. Below this are the various stacking methods that can be used
which are:
Arithmetic
Simple addition of all pixel values determines the output pixel value
Median
The median value of all pixel values determines the output pixel value
Min-Max rejection
The lowest and highest values are thrown out and the remainder added.
Adaptive weighting
A robust average based on Stetson's Artificial Skepticism Stacking algorithm (I like this one)/
Sigma clipping
Pixels that deviate from the median the most will be rejected in the final output. The rest will be
added.
Sigma median
Similar to Sigma clipping but a rejected pixel will be replaced by the median and added with the
rest.
If the 'Number of iterations' box is un-greyed (depends on
the radio button for type of stack selected) then the number
of iterations can be entered. I've found that three to five is
about right.
When the stack is finished the final image will be displayed
in the IRIS window.
If any post-processing is to be done such as the removal of
gradients or noise then save the image as a temporary file.
The command to do this is:
save temp

Fig. 143

If all of the remaining processing is to be done in an image
manipulation package such as PhotoShop or the GIMP then
the final image an be saved in one of several formats by
selecting FILE->SAVE which acts much like any other
Windows application.
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Some IRIS Procedures
Gradient removal
If there is a noticeable gradient in the image background such as may be present if shot from a light
polluted area then some steps should be taken to remove the gradient and any high-frequency nonuniformities.
To start removal of any gradient in the processed
image first type the following into the command
window.
save temp
bg
In the Output window IRIS will print the level of
the background which I'll call BGVALUE. Next
the following commands are issued:
bin_down BGVALUE
save mask
To see the results of the above the Auto button in
the threshold windows is clicked on and then the
image zoomed out. If the background on the mask
created doesn't look like even then re-load the
image using:

Fig. 144

load temp
and re-run bin_down with a new BGVALUE adjusting it up and down until the mask looks correct.
Always re-load the temporary image before each change in BGVALUE and when the mask looks
correct save it with the save command..
When the mask looks right clicking on PROCESSING->REMOVE GRADIENT (POLYNOMIAL
FIT) will bring up the dialog window in Figure 144. Various combinations of values here can be tried
but selecting 'Medium' for both Background detection and Fit precision generally works. Check Use a
mask and enter the name 'mask' (which you created above) in the entry box. Also, Balance
background color should be selected.
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After the dialog box is executed IRIS will analyze
the image and and subtract any gradient. A nonautomatic method would be to type the following
commands into the command window.
save temp
The image should now have a very even background
with very little, if any, variation.

Noise removal
To remove noise in IRIS using an adaptive filtering
schema on a 3x3 or 5x5 pixel matrix use the
command
af3 [COEF] or af5 [COEF]
Where COEF is between .1 and 5. Increasing the
COEF value will make the noise suppression
stronger.
There are many other functions that can be
performed in IRIS, some which work only on the
image that is loaded in memory and others that can
be done to a whole sequence. The Processing menu
items are shown in Figure 145.
Blur filters, wavelet filters and enhancement
functions such as unsharp masking (which is one of
the functions that can be run on a sequence) are
available from this menu. Many other functions are
available as typed in commands.
IRIS has the ability to run command scripts which
menas that if there are a sequence of commands that
are commonly used they can be stored as a script file
and run from the command window by typing in:
run command_file_name
The final image is not saved so this has to be done
Fig. 145
manually. I generally save my final files as TIFF
files and do it using the FILE->SAVE menu item which brings up a Save as dialog (not 'normal' but
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this is what it does) which allows a file name and file type to be selected for saving. The final image is
now ready for PhotoShop, the GIMP or whichever software will be used.
IRIS can be downloaded from:

http://www.astrosurf.com/buil/us/iris/iris.htm

An image of NGC6946 taken by the author with an AstroTech 8” Imaging
Newtonian and a modified Canon 500D. Ten 5-minute images at ISO800.
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Processing Images Using the GIMP
After an image has been
registered and stacked it will need
some processing to bring out all
of the detail that has been
captured. In this section I will
process an image of M27 that was
captured with an AstroTech 8” f/4
Newtonian and modified Canon
500D camera. I will be using the
GIMP under Linux which works
the same as the Windows version.
Both are free. In PhotoShop the
routine is about the same.
The output of DSS is a 16-bit
TIFF image but the GIMP can
handle only 8-bit TIFF images. If
Fig. 146
not being able to handle the full
16-bit image will be an issue then the initial histogram stretching can be done in just about any other
image processing software. The image returned to me by DSS is shown in Figure 146.
The generated image is generally very dark and little detail is visible. Don't worry, all the detail that one
could want is there, it's just waiting to be dragged out by main
force.
Initially I spend my time stretching the histogram. Looking at the
histogram in this image you will see that there is only a large
spike far to the left side. What we want to do is to move that
hump in the middle of the histogram and spread it out so that it
covers most of the horizontal axis.
To do this I make use of Layers and Curves. Levels changes the
image linearly and Curves makes non-linear changes. Initially I
select
Colors->Levels from the menus which brings u the
dialog in Figure 147.
If there is a G2 spectral class star in the image I would set the
white point (the pointer under the far right edge of the histogram)
be clicking on the right-hand pointer below All Channels then
clicking on the G2 star. Why? Our sun is of that spectral class
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Fig. 147

and it gives us our definition of 'white' as a consequence of the evolution of our eye. If there are no
recognizable G2 stars, as in the image I'm working with here, I just leave the white pointer where it is.
After setting the white point I stay in the the Levels dialog. Notice that the histogram is packed tightly
against the left side of the chart. Not much wiggle room there but I'll grab the pointer under the left side
of the histogram and move it slightly right to the left edge of the spike and then grab the centre pointer
(grey point) and move it slightly to the left (just slightly) to bring out some brighter detail.
Generally I don't suggest playing with the grey point so early in processing but this image called for it.
Once the levels look good then I'll move on to Curves.

Fig. 148
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The next step is to select Colors->Curves to open the Curves dialog. Again I'm be working with all
channels so 'Value' is shown in the Channel drop-down.
I'm going to stretch the histogram using small actions so I grab the middle of the curve shown in the
chart and drag it up and to the left about one box. The result of each action is shown as it is being done
so more or less may be used but I've found that many iterations using a small amount of change in
Levels and Curves is better than making large adjustments.

Fig. 149

Already I'm seeing some of the detail and colour starting to emerge from the image.
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Now that I've adjusted the Curves I go back to Levels. Notice that the histogram has moved right and
has started to spread nicely. Once more I grab the left hand pointer and move it to the left side of the
bump in the histogram. This time I'm not touching the centre pointer as the grey point seems fine.

Fig. 150
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From Levels I go back to Curves. Notice the pattern here. Levels-Curves-Levels-Curves until things
look almost right. The last adjustment I'm doing is in Curves where I'm using a a flat S-shapedto I
tweak the dark and light output to where I want them before moving on. M27 is now fairly bright and
there are a lot of field stars around. I want it framed better so it's time to crop.

Fig. 151

I select Files->New and create a new window of 2400x1600 pixels. Then, in the original image I select
Select->All and Edit->Copy. This grabbed the whole original image which I then paste into the new
window using Edit->Paste.
Using the 'Move' tool (crossed arrows) I drag the image to where I wanted the framing to be then
selecte Layer->Anchor Layer to set it.
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The next step I take is to bring the colour to where I want it so I select Colors->Color Balance and
tweak the Shadow, Midtones and Highlights.

Fig. 152

Now that the balance is roughly set it's time to punch up the colour, to make it 'pop' as it were. To do
this I'm going to decompose the image into channels, but not into the RGB channels that we're used to
talking about. I'll be using something called LAB which is in the drop-down box under Colors>Components->Decompose.
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Decomposing to LAB opens a new image window with three layers named L (Luminosity), A (A
channel) and B (B channel).

Fig. 153

I Select the A channel then select Colors->Brightness and Contrast and pull the contrast up about 25
points. I repeat this with the B channel then I select Colors->Components->Recompose in the
decomposed image and click on the main image to see the outcome. If the colours need more punch I'll
go back to the decomposed image and push the contrast up on the A and B channels again.
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When the image has been recomposed the colours are much more vibrant. This generally only works
with images of nebulae but I suppose it would also punch up the colour in the HII regions of galaxies.

Fig. 154

Now just about all the colour adjustment is done and it's time to think about noise and other
enhancements.
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I like to handle noise and detail at the same time and have come up with this little procedure that I use
quite often.
First I click Layer->Duplicate Layer which creates a copy of the main image layer. In that layer I
select Filters->Blur->Gaussian Blur and set it so that it blurs both directions to 40 pixels. Then I
select Colors->Brightness and Contrast and drag both Brightness and Contrast back 40 units.
When this is done I select the Background Copy layer in the list and make the layer Mode 'Overlay'.
Then I select Image->Flatten Image.

Fig. 155

If there is any noise left over then I use a GIMP plugin called 'Wavelet Denoise' (see the section on
GIMP plugins) to get rid of the rest. This does a nice job without many of the artifacts that other antinoise tools use.
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Any further processing will be tinkering with colour, gradient etc.
This is the outcome of this little processing session:

Fig. 156

The GIMP can be downloaded from:

http://www.gimp.org
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Removing Gradients with the GIMP
There are times when an astro-photo has a noticeable gradient in some direction across the image. This
means that the dark sky is lighter on one side than the other (or top to bottom, or on a diagonal). There
are fancy tools for getting rid of gradients but the GIMP has a gradient tool that does the trick nicely.
To use this tool select the Gradient Tool from the toolbox (Figure
157) which will display the options for the Gradient tool.
What we want to do with it is to smoothly remove the gradient from
the image without losing any detail, or as little detail as possible. To
start with set the options as follows:
Mode
Select Overlay from the drop down list.
documentation for the GIMP.

From the

Overlay mode inverts the pixel value of the lower layer,
multiplies it by two times the pixel value of the upper layer,
adds that to the original pixel value of the lower layer, divides
by 255, and then multiplies by the pixel value of the original
lower layer and divides by 255 again. It darkens the image,
but not as much as with “Multiply” mode.
That sounds ominous, but it does the trick very nicely for
removing a gradient.
Opacity
Start with the opacity set around 30% and adjust it as needed.
We don't want the gradient stomped into the ground but rather
gently massaged away.
Gradient
The gradient type we'll be using is 'FG to Transparent' which
starts with the foreground colour and fades it away to nothing
as the gradient is added. Make sure that the foreground colour
is black.
Offset
The offset adjusts how far into the gradient add the darkest
part extends. Start with about 30% and adjust as needed.
Fig. 157
126

Shape
We are removing a gradient that goes in one direction so we'll use Linear.
All of the rest of the options can be left at defaults unless there is a reason to play with them. To
activate the gradient, click on the image where you wish to start and then drag the mouse any direction
or distance to where you wish to end. When you let go of the mouse button the gradient will be
activated and you can see your work. If you wish to adjust then press Ctrl-Z to undo the previous
attempt, adjust the parameters and try again.

The southern Milky Way shot by Dave McCarter in Chile on a tripod-mounted
Nikon DSLR.
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Required Plugins for the GIMP
There are several plugins for the GIMP that really should be kept at hand. I've listed these with their
URL in the GIMP Plugin Registry.
GIMP Wavelet Denoise
http://registry.gimp.org/node/4235
The wavelet denoise plugin is a tool to reduce noise in each channel of an image separately. The
default colour space to do denoising is YCbCr which has the advantage that chroma noise can
be reduced without affecting image details. Denoising in CIELAB (L*a*b*) or RGB is
available as an option. The user interface allows colour mode and preview channel selection.
The denoising threshold can be set for each colour channel independently.
GIMP Wavelet Sharpen
http://registry.gimp.org/node/9836
The wavelet sharpen plugin enhances apparent sharpness of an image by increasing contrast in
high frequency space. The amount of unsharpness of the original image can be taken into
account by adjusting the sharpening radius. As an option one can choose to sharpen the
luminance (YCbCr) channel of the image only.
GIMP Simple Bilateral Blur
http://registry.gimp.org/node/24208
This is a surface blur filter based on a simplified version Porikli's O(1) bilateral filter.
GIMP Astronomy Plugins
http://registry.gimp.org/node/2352
A set of plugins and scripts for astronomical image processing. These are not intended for
scientific image processing.
Plugins:
• Align layers using centre of brightness or 2D (fourier) cross correlation or gauss fit,
subpixel-resolution, with de-rotation!
• Merge layers using different mean values, including arithmetic/geometric mean, median,
and arithmetic mean of x sigma around median.
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•

•
•
•

Create a background gradient (artificial flat field) from a layer by fitting a 2D 4th order
polynomial through pivotal points. Cut out large bright nebulae to avoid wrong pivotal
point values!
Star rounding: Round longish stars (due to tracking errors...)
Create an artificial galaxy. Only elliptical galaxies yet.
Create artificial stars: Using different star distributions, split into background, object and
foreground stars.

•

Scripts:
•
•
•
•
•
•

Set mode for all layers
Set brightness / contrast for all layers
Normalize all layers
Subtract dark frame from each layer
Divide all layers by a flat field
Draw border with image information

GIMP Exposure Blend
http://registry.gimp.org/node/6708
This is the 'HDR' plugin. Exposure-blend makes quick work of blending 3 bracketed exposures
into a detailed, realistic, extended contrast image. It has many features to save the drudgery of
assembling contrast blended stacks yourself.
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Do It Yourself Section
Simple things that anyone handy can put together

M33 by Rick Saunders
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DIY Circuit Boards
Printed circuit boards used to be fairly difficult to make and
anything other that the extremely simple required equipment
that most people didn't have. Since the advent of laser
printers though making useful and complex boards has
become almost simplicity itself. Once a circuit has been
designed it can be transferred to a piece of copper-clad in
very short order using a method called toner transfer.
The basis of the system is that laser printer toner melts when
heated and will stick to copper. So a circuit board can be
Fig. 158
drawn on a computer, scaled to the correct size, printed on
the laser printer and then transferred simply to the copper. The copper can then be etched away leaving
any protected by the toner behind. This leftover serves as the traces and pads of the circuit board.
The only specialty item needed is the etchant. Ferric chloride is carried by most shops in liquid form
and some may have ammonium sulphate in powder. The powder is easier to keep and doesn't stain
things but the solution created by it must be kept quite warm for the best results. This can be had from
many sources on-line or, from most electronics supply stores. Other than the etchant all that is needed
are:
1)
2)
3)
4)
5)
6)
7)
8)

A piece of copper-clad. This is fibreglass or plastic with a thin sheet of copper bonded to it.
An old clothes iron. Steam is not needed and is a detriment so make sure it can be turned off.
Some glossy photo paper or glossy (white) magazine pages.
An old tooth brush.
An old tub or shallow container.
A Dremel tool with .8 mm and 1 mm drill bits.
Some acetone.
A Scotch-brite pad or fine steel wool.

The steps are:
1) Create the design in your favourite drawing package or circuit design software. It has to be laid
out reversed left-to-right (Figure 158). I prefer the GIMP but just about any will work.
2) Print the design onto glossy photo-paper or glossy magazine paper. I always check my design
by printing it on regular paper first and checking hole spacing etc.
3) Clean a piece of copper-clad circuit board using Scotch-bright pads or steel wool. Use alcohol
or acetone to tidy it up after scrubbing.
4) Lay the paper toner-side down on the copper-clad board.
5) Using an old clothes iron press the printout at high temperature for a minute or so. The heat of
the iron will melt the toner which will then stick to the copper when cooled.
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6)
7)
8)
9)

When finished ironing douse the board in cold water.
Let it soak a bit and then peel the paper away. The toner will stay behind.
Use a tooth-brush to clean all traces of the paper off of the copper-clad.
Immerse the copper-clad in an etchant. The container holding the etchant should be in a warmwater bath. This will speed up the process. Agitate it periodically.
10) After all of the unwanted copper is gone remove the toner using acetone.
11) Drill any holes needed in the board.

Fig. 159

At this stage the board can be tin plated if desired to make it easier to solder parts to, a process which
also serves to protect the copper. The board is ready to be populated with parts. When all the soldering
is over nail polish can be used to further protect the copper from the elements or a can of purpose-made
spray lacquer can be purchased to do the job. The board is then ready to be used.
Figure 159 shows a board that I built that provides focus, anti-dew heat, shutter control, auto-guiding
and other functions to my Rajiva-modified HEQ5.
There are several free PCB layout tools available with the most popular being Eagle from CadSoft. I
generally do the layout for my circuit boards using the GIMP and space the holes for dual-in-line IC
chips 16 pixels apart. This allows me to set the scale at 160 dots-per-inch for printing so that I have
perfect spacing for parts. Before etching I generally print the finished layout on regular paper to check
for any component spacing issues or other problems.
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An Efficient DIY Anti-dew Heat Controller
If one is handy with a soldering iron building an effective heater controller is simple. Dave McCarter,
president of the London Centre of the RASC has designed a very efficient little circuit that can handle a
lot of current.
The circuit is based on a 555 timer and uses a field-effect transistor (FET) to switch the loads on and
off. The circuit allows a range in duty-cycle of 5% to 95% and is adjustable using a simple
potentiometer.

Fig. 160
From the schematic the efficiency of the circuit is apparent. When there are no loads connected the
only current being drawn is the ~5 mA going through the LED when powered by 12V. This serves as a
power-on indication. When a load is connected the LED will dim and brighten as the potentiometer is
adjusted to give an indication of the amount of heat being provided.

Fig. 161
The circuit designer has specified a 'polyfuse' (Figure 161 part F1). These are temperature sensitive
parts that will pass current to a specified level and then open up to cut off the power. Unlike a standard
fuse these are resettable and, when the problem causing the overload is corrected will re-set allowing
the circuit to continue functioning. Much more user-friendly than having to change fuses.
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Fig. 162
Figure 162 is an actual circuit board mask that can be used following the instructions in the previous
section to make the board needed for the circuit. To size it correctly the eight holes for the 555 timer
should be in two rows .3 inches apart and spaced .1 inches between the holes in each row. The spacing
for the rest of the components is not critical as long as the leads are long enough to reach. The resistors
and diodes can lie flat against the board or stand up if space saving is a goal (Figure 163).

Fig. 163

For good solder joints the hot iron should be touched to the junction of the part and board for a second
or two to pre-heat both and then touching the joint with the solder and letting it flow into the joint.
For more information see Dave's article at:

http://www.astro.uwo.ca/~rasc/HEATER.pdf
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This guided image of M13 was taken by the author using an unmodified Canon
XT and a Stellarvue 102ED refractor.
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DIY Anti-dew Heat Strip
An anti-dew strip is just a resistive load. To build one is quite simple.
Bill of materials:
bag of suitable resistors
some two-lead 20 gauge wire
a male RCA connector
some solder
soldering iron
a metal coat hanger
1/4” heat-shrink tubing
roll of duct tape
Start by determining how many resistors are required. Measure the inside diameter of the front cell of
the optical tube. This heat strip will fit into the cell in front of either the objective or corrector plate. A 1
ohm, 1 watt resistor is about 10 mm long in the body so divide the circumference by 20 mm (two times
the body length) to get roughly the number of resistors.
Most medium-sized telescopes can work with 15 W of heat at maximum. Larger telescopes may need
20 W and small refractors less. Let's use the 15 W value for maximum power and 30 resistors in the
strip. Dividing 15 by 30 tells us that each resistor needs to radiate ½ watt of power. Two watt resistors
here would be a bit of overkill so select 1watt parts.
We have 15 W at maximum and are spreading it out among 30 resistors.
For 15 W at 12 V (nominal) the total resistance of the strip should be ( 12
* 12 ) / 15 or about 10 ohms. Ten ohms spread out across 30 resistors in
series tells us that we need .33 ohms per resistor. Digikey
(www.digikey.ca) has .33 ohm/1 W resistors in bags of 10 for about 40
cents each (Figure 164). The part number is 0.33WCT-ND
As I mentioned, the resistors will be soldered together in series, that is,
one after the other in a long line (Figure 165). Keep them about 20 mm
Fig. 164
centre to centre and just keep stringing them until there are more than
enough. Then wrap them around the inside of the corrector or objective
cell and see how many need to be snipped off and remove these.
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Fig. 165
The resistor string has to be pulled through the heat-shrink so take some waste wire and solder it to one
end of the string of resistors, fish it through the heat-shrink then pull the resistors almost all the way
through. Unsolder the waste wire and solder one lead of the two-lead wire onto that end of the resistor
string. Pull it through enough to be able solder the other lead onto the far end. Centre and trim the heatshrink and shrink it into place (I use a lighter or a burner on the gas range). This is your heat strip and
should fit nicely in the cell.
Now cut a piece of metal coat hanger to the same length as the finished string of resistors plus 50mm.
Cover it with heat-shrink and shrink the tubing on. Bend it into a circle and turn up the two ends 90
degrees and fit it to the cell so that the turned up ends are like handles that can be squeezed together to
insert/remove the circle.
Finally, fit the string of resistors to the
covered coat hanger and tape them on
with ripped bits of duct tape (Figure 166).
Solder the male RCA connector onto the
end and the heat strip is done.
This will last a long time if it is left in
place but this will mean cutting a notch in
the dust cover. If used with a dew shield
no imaging sessions will ever be ended
by a bit of moisture.

Fig. 166
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DIY DSLR Power Supply
In the field there is nothing more aggravating than having camera batteries die. This being the case I
run my Canon cameras from the 12 V sources that I have at hand. I could have done this using a small
DC-AC inverter but that would have been overkill. So I built a 12 V-8 V adaptor for my camera.
The heart of the circuit is an LM317 adjustable output voltage regulator. These are wonderful little
chips that can source 1.5 amperes of current while providing a stable voltage source. For the Canon
cameras the voltage needed is around 8V so the circuit shown is tuned to that output.

Fig. 167
For any other voltage source the 1200 ohm (1K2) resistor has to be changed out with another that meets
the following equation.

The last value value can be discounted as IADJ is very small.
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A circuit this small is easily built using perf-board or the parts could just be air-wired together. Some
form of heat sink should be used on an LM317. Many people get by without one but a twenty cent part
is always good for peace of mind.
Here is a table of resistor values and voltages.
R2 Resistor

Output voltage

680 ohms

5.11 volts

820 ohms

5.91 volts

1000 ohms

6.93 volts

1200 ohms

8.07 volts

1500 ohms

9.77 volts

When the circuit is finished and tested there has to be some way of getting the power into the camera. I
suggest purchasing an AC adaptor made for the camera and modifying the cable by adding a 3.5 mm
male and female phone plug in-line. Put the male plug on the camera side. If the adaptor has a 3.5 mm
female to provide power then the AC adaptor is still usable.

Fig. 168
Remember that phone plugs short when inserting or removing so plug them in before any power
is turned on.
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DIY USB Hub Power Supply
As the USB ports from a laptop or computer can only source 500 mA of current there are times when
the hub needs to be plugged into a wall-wart or other power source. If there are mains near the
telescope then a wall-wart is fine. If not then using an inverter for something like a USB hub is overkill.
The best way to power the hub is to use the 12 V that I have on
hand.
For this project I used an LM7805 three-terminal positive
voltage regulator (Figure 169). These are very handy chips that
have on-board short-circuit, over-temp and over-current
protection. They come in various output voltages and can handle
a 1 ampere load. With large loads they can develop a lot of heat.
About Heat
The 7800 series chips on their own get hot... sometimes very
hot. They heat up around 65 C° for every watt of current that the Fig. 169
parts attached to them draw according to the following equation:
Heat generated over ambient (Deg C) = (Input voltage - Output voltage) * current * Tc
(Tc is the thermal resistance of the chip to ambient... 65 C/W with no heat-sink)
This means that if the input voltage is 13.6 V and your output voltage is 5 V then there is a voltage drop
of 8.6 V. If the load is 1 A then the chip will heat up to about 550 C° (it won't really, it would have shut
itself down when the core got to
about 150 C°).
There has to be some place for the
heat to go: a heat-sink. For a 5 V
regulator with a 13.6 V source the
part reaches too hot somewhere
about 200 mA, for an 8V regulator
about 300 mA (I have used a bare
7808 to power my Canon T1i): both
of these with no heat-sink. This is
the 65 C°/W 'thermal resistance to
ambient' value of the part. If we add
a heat-sink then this value changes
and the thermal resistance becomes

Fig. 170
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that of the heat-sink. So a 10 C°/W heat sink will allow our 5 V part to handle a load of about 1.75 A
(higher than it's rated for) In this case, the heat-sink will be very hot but the regulator won't burn up.
For this converter I used a very large heat-sink from a 486 or
Pentium (I can't remember) computer that, if I remember
correctly, was rated at about 3 C°/W. At full load it should only
get to about 25 C° above ambient.
Firstly a hole was drilled and tapped into the back of the heatsink and the 7805 regulator was screwed tightly onto it.
Thermal grease should be used between the 7805 and the heatsink if available, it helps. Then the positive lead from the source
was soldered to the regulator's input leg and the positive lead to
the powered device (USB hub) was soldered to the output leg.
The input and output ground leads were soldered together with
the regulator's ground leg. A .33 uF capacitor is soldered in
place from the input positive to ground.
Once this was done it was put into an old project box I had
lying around with a suitable cutout made in the box for the heat
sink to be able to 'see' the outside air. That's about it. It
functions perfectly and, as I mentioned at the top, is very
Fig. 171
simple.
With a single 7800 series regulator the current limit is 1
ampere. With a 4-port hub it would be nice to provide 500 mA to each port with enough headroom for
the port itself. The elegant way to do this would be to use a SimpleSwitcher but there is an inelegant
way that is cheap and easy: parallel 7800 regulators. To provide 2.5 A I suggest 4 regulators in parallel.
To keep the load balanced a .47 ohm, 1 watt, 1% resistor on each output would work. A .33 uF filter
cap on the input and a .01 uF cap (optional) on each output rounds things out. The black common lead
in Figure 172 is ground.

Fig. 172
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Adding a Motor to a Focuser
Being able to control a focuser remotely is quite advantageous. As most imagers work from a computer
not having to go back and forth from the console to focus an image saves a lot of time and aggravation.
Building one is not very difficult if access to
either a wood or machine shop is available.
Adding a powered focuser to my AstroTech 8”
Newtonian was made simpler by the availability
of the finder bracket; the finder having been
relegated to other chores. All that was needed
was a dovetail that would fit into the bracket and
some method of attaching a DC motor to the
dovetail. Both of these were taken care of in a
friend's machine shop. My parts are aluminum
but wood would do just as well.
I had on hand a motor and gearbox that were
discarded from the upgrading of my HEQ5
mount and these were pressed into service. A
pulley was machined from brass to fit the motor,
but having a standard 6 mm output shaft, a
pulley could be purchased that would fit. Again,

Fig. 173
a wooden spool would have sufficed.

On the focuser end the fine-focus knob was replaced by a knob/pulley again machined from brass. The
knob that came on the focuser could have had a
notch cut in it but brass is so sexy.
A piece of aluminum angle was used for the
motor bracket. Suitable holes positioned and
drilled on one side allowed the motor to fit in
nicely. Slots milled on the other mated with
holes in the dovetail to allow the bracket to be
adjusted. The whole thing was sculpted on the
band-saw and sanded down to be pretty.
Power to the motor comes in via an RCA plug
on a piece of L shaped plastic that is screwed to
the dovetail. JMI's Moto-Focus controller runs
the motor nicely. Connecting the motor to the
focuser is a 1/8” rubber O-ring. A belt would be
better but geometry wasn't on my side so the
ring worked out best for me.

Fig. 174
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DIY Focus Motor Controller
Powered focusers are very nice to use. Being
able to focus a telescope with no 'jitters' or
'jumps' in the image while looking through an
eyepiece of monitoring a camera makes
achieving focus easy. Building one is fairly
simple for anyone handy with a soldering iron
and
the
costs
are
about
$35.
The board I've designed works around a 555
timer circuit to provide variable speed. The
timer turns on and off a power FET which
provides current to a DC motor. A 50K
potentiometer allows speed adjustment and two
Fig. 175
DPDT on/on push-button switches provide for
direction control and turn on and off the circuitry. This makes for a very efficient controller which
should run for many months on a single 9 V battery.
The schematic is shown in Figure 176.

Fig. 176
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There is no on/off switch in this circuit as the push-button switches each act to provide power to the
timer circuit. There is no power use at all until a direction button is pressed. The switch wiring is shown
in Figure 177.
Each switch utilizes 5 of its 6 terminals. The
motor side of each switch is labeled E, C and D
for 'Enable', 'Common' and 'Default'. These are
wired to the corresponding pads in the layout in
Figure 178. The Common terminals connect to
the motor terminal on Figure 178 (labeled
MTR). The E terminal is connected when a
button is pressed and the D terminal is
connected when a button is not pressed.

Fig. 177

SW 3 is the other side of each switch and both switches are connected together in parallel and serve to
provide power to the timer circuit. The wires going to the SW3 pads in the layout are not polaritysensitive.
This unit can provide smoothly variable motor speeds from
around 30% to around 95%. Depending on the motor selected
this can give extremely slow, and therefore accurate focusing.
The circuit is designed to dynamically brake the motor when
either button is released which also adds to the accuracy. A
motor can be 'pulsed' by quick button presses to move a
focuser in extremely small amounts.
The circuit here costs around $35-40 to build. Most of the parts
are common but the switches are not. The DigiKey part
number for the switches is 360-2152-ND. All of the other parts
can be ordered at the same time.

Fig. 178
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Some Nomenclature
Imagers bandy about a lot of terms when it comes to taking and processing images. Things like dark
frames, stacking, histogram stretching, etc. will pop up all over the place so I've put a small list of them
together.
ADU
An ADU is an Analog/Digital Unit. This is the unit stated to measure the value of a pixel in a
CCD image. If the gain of the camera is known then the number of electrons and therefore
photons (using the quantum efficiency value) that were collected by the sensor.
Amplifier glow
Known as 'amp glow' this is the heat given off by the electronics in the camera showing up on
the image due to heating of the sensor. In Canon Rebels amp glow usually shows up at the
bottom right of a frame.
Auto-guider
An auto-guider is a device that uses a digital camera and electronics to move a telescope mount
to keep a star centred
Bias Frames
A bias frame (may also be known as 'offset') is an image taken with no actual exposure time.
These images are used to adjust the light frames (the actual pictures) to mitigate the noise
inherent in the chip itself. If a camera won't take a 0-length image (shot with the shutter closed)
then a 'pseudo bias' can be taken by leaving the lens cap on, setting the camera for its fastest
shutter speed, standing in a a dark closet and pressing the shutter. Take a few of them. Not to be
confused with a dark frame which uses an exposure of the same length as the light (picture)
frames.
Bit Depth
A CCD camera's analog signal has to be converted to ditigal values in order for a computer to
work with them. This is done by an Analog-Digital converter. The bit depth determines the
number of values that can be assigned to a pixel: 256 for 8-bit and 65536 for 16-bit.
Collimation
Collimation is the alignment of all of the optical components of a telescope.
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Dark frames
These are images taken before, after or during your capture of light frames and are taken with
the dust cover on the scope so no light gets in. These are used to adjust the light frames to
correct for things like amplifier glow, hot pixels and gradients. They should be taken at the same
temperature that the light frames were taken at and have exactly the same exposure settings
(ISO, length etc.)
Flat frames
Flat frames are images taken with a constant, 'flat' light source
such as that from a light box or the dusk sky. They show up things
like dust motes on the sensor, vignetting or uneven illumination in
the optical system. Exposed them to about 1/3 histogram as in
Figure 179.
Full Well Capacity
This is the number of electrons that a
saturating and possibly causing blooming

pixel can hold before

Fig. 179

FWHM
Full width at half maximum. The width of a star at half-maximum-intensity.
Gain
When a CCD is read the pixel charge may be in micro-volts and an amplifier is needed to bring
the signal into the range where it is usable. The amount that the signal is increased is the gain.
An amplifier not only reads the signal, but reads any noise inherent in the chip which has to be
accounted for.
Gradient
An image showing a gradient has dark sky at one edge lighter than the dark sky at another edge.
This is not wanted. Some gradients such as those caused by the optical system can be handled
by flat frames, others need a bit of ingenuity.
Histogram
A histogram is a graph of how many pixels of each intensity level occur in an image. They are
X/Y graphs and show pixel intensity along the X axis and number of pixels on the Y axis. An
unstretched histogram may look like a flat line with a large spike at the far left side.
Histogram stretching
Turning the histogram with a 'flat line with a bump' into a wide-based mountain. Most software
allows this to be done linearly (levels) or non-linearly (curves).
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Fig. 180
Hot pixels
These are pixels that have 'turned on' on your sensor for whatever reason. They show up in the
image as static red, green or blue 'dots' that are fairly bright. Dark frames usually get rid of them
but sometimes one has to go through a final image removing them with the clone stamp tool.
Light frames
These are the actual pictures. The shutter is open, the telescope is tracking and the sensor is
being bathed in ancient photons.
Quantum efficiency (QE)
The percentage of photons hitting the photo reactive surface that will produce an electron-hole
pair (the electron in our bucket).
Skyglow limit
Every image will show some skyglow which is just the brightness of the background (or
foreground if it's due to light pollution). The skyglow limit is the length of exposure where the
skyglow swamps any actual data.
Sensitivity
Modern sensors are usable to very low light levels and therefore are considered highly sensitive.
Many can operate down to near zero lux (lumens/sq. metre).
Stacking
Stacking involves taking many short exposures and adding them together to make one long
duration exposure. Good software will register (align) all of the images while it stacks them.
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Links
Mounts
AstroPhysics
Celestron
Losmandy
Meade
Orion
SkyWatcher
Vixen
Tripods and Piers
Telescope Perf. Improvements
Optics
ASA
Astronomy Technologies
AstroPhysics
Borg
Celestron
GSO
Meade
Orion
Planewave
Questar
RCOS
Stellarvue
TeleVue
Vixen
William Optics
Rings and Dovetails
ADM
Antares
Ken's Rings
Losmandy
Orion
Vixen

http://www.astro-physics.com
http://www.celestron.com
http://www.losmandy.com
http://www.meade.com
http://www.telescope.com
http://www.skywatchertelescope.net
http://www.vixenoptics.com
http://www.tpiastro.com
http://www.astrosysteme.at
http://www.astronomytechnologies.com
http://www.astro-physics.com
http://www.sciencecenter.net/hutech/borg/
http://www.celestron.com
http://www.gs-telescope.com
http://www.meade.com
http://www.telescope.com
http://www.planewave.com
http://www.questarcorporation.com
http://www.rcopticalssystems.com
http://www.stellarvue.com
http://www.televue.com
http://www.vixenoptics.com
http://www.williamoptics.com
http://admaccessories.com
http://www.antaresoptical.com
http://www.kendauzat.net
http://www.losmandy.com
http://www.telescope.com
http://www.vixenoptics.com
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Electrical Power
Canadian Tire
Kendrick
WalMart Canada

http://www.canadiantire.com
http://www.kendrickastro.com
http://www.walmart.ca

DSLR Cameras
Canon
Hutech
Nikon
Olympus
Pentax

http://www.canon.ca
http://www.sciencecentre.net/hutech
http://www.nikon.ca
http://www.olympuscanada.com
http://www.pentaxcanada.com

CCD Cameras
Apogee
QHY
SBIG
StarlightXpress

http://www.ccd.com
http://www.qhyccd.com
http://www.sbig.com
http://www.starlight-xpress.co.uk

Astro-photography With Camera Lenses
Astrotrac
http://www.astrotrac.com
Two Old Guys Astrogear
http://www.togastro.com/
Chris L. Peterson
http://www.cloudbait.com
Guiders
Borg
Celestron
KW Telescope
Orion
QHY
SBIG
Author 's site

http://www.sciencecenter.net/hutech/borg/
http://www.celestron.com
http://www.kwtelescope.com
http://www.telescope.com
http://www.qhyccd.com
http://www.sbig.com
http://www.togastro.com/ozzzy/finder_guider.html

Focusers
Antares
JMI
Moonlight Telescope Acc.
Orion
Starlight Instrumets
William Optics
Robo-Focus
Author's site

http://www.antaresoptical.com
http://www.jimsmobile.com
http://www.focuser.com
http://www.telescope.com
http://www.starlightinstruments.com
http://www.williamoptics.com
http://www.robofocus.com
http://www.togastro.com/ozzzy/at8in_mods.html

149

Focusing Masks
Ozzzy's Place
Bahtinov Grabber
Lazer Tech

http://www.togastro.com/ozzzy/bahtinov_masks.html
http://www.njnoordhoek.com/?p=325
http://www.lazer-tech.ca/company.html

Automatic or Remote Focusing
Two Old Guys Astrogear
Technical Innovations
Lunático Astronomia

http://www.togastro.com
http://www.robofocus.com
http://tienda.lunatico.es

Field Flatteners/Reducers/Correctors
Astronomy Technologies
AstroPhysics
Celestron
Meade
Orion
William Optics
Baader Planetarium
TeleVue

http://www.astronomytechnologies.com
http://www.astro-physics.com
http://www.celestron.com
http://www.meade.com
http://www.telescope.com
http://www.williamoptics.com
http://www.baader-planetarium.com
http://www.televue.com

USB Hubs
Belkin

http://www.belkin.com/

Dew Control
Kendrick
Orion
Thousand Oaks
Author's site

http://www.kendrickastro.com
http://www.telescope.com
http://www.thousandoaksoptica.com
http://www.togastro.com/ozzzy/my_dew_zapper.html

Filters
Astrodon
Astronomik
Hutech
Lumicon
Orion

http://www.astrodon.com
http://www.astronomik.com
http://www.sciencecentre.net/hutech
http://www.lumicon.com
http://www.telescope.com

Exposure Control
Two Old Guys Astrogear

http://www.togastro.com

Flat Frames
Greg Pyros
David Haworth

http://www.gregpyros.com
http://www.stargazing.net/david/
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Collimation
Cat's Eye Collimation
Celestron
Hotech
Howie Glatter
Meade
Orion
Bob's Knobs

http://www.catseyecollimation.com
http://www.celestron.com
http://www.hotechusa.com
http://www.collimator.com
http://www.meade.com
http://www.telescope.com
http://www.bobsknobs.com/

DIY Circuit Boards
CadSoft

http://www.cadsoftusa.com
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Illustration and Image Credits
All images and illustrations not listed below are the author's
Frontispiece
Hardware Section Page
Processing Section Page

Marcus Stevens
Jon Gunning
Jon Gunning

Mounts
LX200
German Equatorial Mount

Chip Frappier
Wikipedia Commons/Marie-Lan Nguyen

http://sites.google.com//site/whistlestopobs

Astro-Physics
Starizona
Telescope Performance Improvements

http://www.astro-physics.com
http://www.starizona.com
http://www.tpiastro.com

Mathis Instruments
Patrick Whelen

http://www.mathis-instruments.com

Tripods and Piers
AP1200 Pier
Accessory Shelf
CGE Tripod Brace/Shelf
Gears and Periodic Error
Worm gear
Stars Through Trees
Optics and Optical Tubes
Simple lens illustration
Achromat illustration
Triplet illustration
Meade f/3.3 Focal Reducer
Coathanger Asterism Area

Wikipedia Commons
Wikipedia Commons
Wikipedia Commons/Egmason
Meade Corp.
Ryan Fraser

http://www.meade.com

Mounting Rings and Dovetail Bars
Telescope Rings
Rotating Rings
Dovetail Bars
Heart Nebula

Orion Telescopes and Binoculars
Parallax Instruments
Astronomy Technologies
Jon Gunning

http://www.telescope.com
http://www.parallaxinstruments.com
http://www.astronomytechnologies.com

Kendrick Astro Instruments
Canadian Tire Corp.

http://www.kendrickastro.com
http://www.canadiantire.com

Electrical Power
Regulated Power Supplies
Inverter
Sensors
Blooming
Multi-panel sensor

Wikipedia Commons/Genetichazzard
Wikipedia Commons/Sloan Digital Sky Survey
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DSLR Cameras
Prime Focus Adaptor
Bayer Filter
Canon T1i
Nikon DR-6 finder

Orion Telescopes and Binoculars
http://www.telescope.com
Wikipedia Commons/Colin M. L. Burnett
Canon Canada
http://www.canon.ca
Nikon USA
http://www.nikonusa.com

CCD Sensors
SBIG ST-8300M
QHY9 Cameras
IC405

Santa Barbara Instruments Group
QHYCCD
Bill Gardner

http://www.sbig.com
http://www.qhyccd.com

Astro-photography With Camera Lenses
Nikon D200
Barndoor Tracker
Astrotrac
Piggy-back Adaptor
Andromeda Galaxy

Nikon USA
Chris L. Peterson
Astrotrack
Meade Corp.
Dan Williams

http://www.nikonusa.com
http://www.cloudbait.com

Celestron Corp.
Santa Barbara Instruments Group
Santa Barbara Instruments Group
Pete Raine

http://www.celestron.com
http://www.sbig.com
http://www.sbig.com

http://www.meade.com

Auto-guiders
Celestron NexGuide
SG-4 Camera
ST-4 Star Tracker
Crab nebula
Focusers
Rack and Pinion
JMI MOTO-Focus

Wikipedia Commons/US Federal Gov't
Jim's Mobile Inc.

http://www.jimsmobile.com

Focusing Masks
Bahtinov Mask
Carey Mask

Wikipedia Commons/astrojargon.net
Wikipedia Commons/Axelottal

Automatic and Remote Focusing
FWHM
Robo-Focus
Seletek Armadillo
JMI PC Focus Control
TOGA LX Guider/Focuser

Wikipedia Commons/Arne Nordmann
Technical Innovations
Lunático Astronomia
Jim's Mobile Inc.
Two Old Guys Astrogear

http://www.robofocus.com
http://tienda.lunatico.es
http://www.jimsmobile.com
http://www.togastro.com

Field Flatteners, Focal Reducers and Coma Correctors
Williams Optic Flattener III
RCOS Flattener
Meade f/6.3 Flattener/Reducer
MPCC
ParaCorr

Williams Optic
RC Optical Systems
Meade Corp.
Baader Planetarium
TeleVue

http://www.williamsoptic.com
http://www.rcopticalsystems.com
http://www.meade.com
http://www.baader-planetarium.com
http://www.televue.com

153

Dew Control
Kendrick's Premier Controller
Thousand Oaks Controller

Kendrick Astro Instruments
Thousand Oaks Optical

http://www.kendrickastro.com
http://www.thousandoaksoptical.com

Belkin
Jon Gunning

http://www.belkin.com

Lumicon
Astronomik
Apogee Imaging Systems
Robert J. Vanderbei

http://www.lumicon.com
http://www.astronomik.com
http://www.ccd.com

AstroEngineering

www.astro-engineering.com

CanonUSA
Two Old Guys Astrogear

http://www.canonusa.com
http://www.togastro.com

?
Orion Telescopes and Binoculars
Hotech Corp.
Hotech Corp.
?

http://www.telescope.com
http://www.hotechusa.com
http://www.hotechusa.com

Greg Pyros
David Haworth

http://www.gregpyros.com
http://www.stargazing.net/david/

USB Hubs
Belkin 4-port Hub
Omega Centauri
Filters
Lumicon Filters
Astronomik EOS Clip
Filter Wheel
Dumbbell Nebula in O-III
Telescope Balance
SCT Balance Set
Exposure Control
Canon TC-80
TOGA Intervalometer
Collimation
Star Images
Cheshire Sight Tube
Hotech SCA Laser Collimator
Laser dot image
Star Images
Flat Frames
Light Box
Pentax and Laptop
Removing Gradients
Southern Milky Way

David McCarter

DIY Anti-Dew Heat Controller
All illustrations

David McCarter

DIY Anti-Dew Heat Strip
Resistor

DigiKey Corp.

http://www.digikey.ca
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DIY USB Power Supply
Regulator

DigiKey Corp.

http://www.digikey.ca
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